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Digital Photo Professional

Ver. 3.4

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Mac OS X 10.4.

» indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu »
[Quit Digital Photo Professional].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

@

@ . Marks information that should be read

N
/TN

before use.

Marks additional information you may find
helpful.

Marks tips for using the software skillfully.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page
€ : previous page
: return to a page you had previously
displayed
Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to

read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the “Shortcut Key List” in the Help for a
list of shortcut keys which are helpful for quick
operation.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW
image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for the RAW image, too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP System Requirements

Following are the main tasks you can perform with images you have

Introduction

downloaded to your computer. o Mac OS X 10310 10.5
) ) ) Computer | Macintosh with one of the above OS installed
View and organize RAW images cPU Minimum 400MHz, PowerPC G3, G4, G5 or Intel Contents at
. . . rocessor
Real-time adjustment of a RAW image pr
. . . . s C T RAM Minimum 512MB
Various image adjustments while maintaining the original image _ Basic
Freely apply a Picture Style Display ReSOIUt.'(m + 1024 x 768 or more Operation
View your image before and after adjustment in the same window Colors : Thousands or more
. . . . This software program is not compatible with UFS (UNIX File System
Trim an image and change its size o S e oram! patible with UFS (UNIX Flle System) [ avanced
. . . Operation
: . DPP also runs comfortably on Intel-based Macintosh since it is a
Correction of lens aberration Universal application.
. . Advanced
Automatic/manual dust erasure processing e

Convert from a RAW image to a JPEG or

Supported Images

This software supports the following image types.

and Printing

TIFF image and save _ Processing
Process large numbers of RAW images in batches Image type/Camera used Extension Lag%?nl:lgmggrs
Transfer the image to image editing software EOS-1Ds Mark 11l EOS-1D Mark IlI g

. . EOS-1D Mark N EOS-1Ds Mark Il =

Print a RAW image EOS-1D Mark Il EOS 5D Editing

JPEG/TIFF

. . \ EOS 40D EOS 30D Images

View and organize JPEG and TIFF images EOS 20D/20Da CR2
. . EOS DIGITAL REBEL XSi/450D '
Real-time adjustment of JPEG and TIFF _ EOS DIGITAL REBEL XTi/400D DIGITAL Reference
images RAW images | EOS DIGITAL REBEL XT/350D DIGITAL
] . . . S L EOS 1000D EOS D6000*

Various image adjustments while maintaining the original image EOS D2000*

Print JPEG and TIFF images EOS-1Ds EOS-1D TIF Index

Col t tibilit EOS 10D
olor management compatibility EOS DIGITAL REBEL/300D DIGITAL .CRW
CMYK simulation for commercial printing EOS D60 EOS D30 @ @

JPEG images EX|f 2.2 or 2.21-compatible JPEG JPG, .JPEG
images
TIFF images | Exif-compatible TIFF images TIF, .TIFF

* Images converted to RAW images that have the “.CR2” extension in
CR2 Converter. For information on CR2 Converter, refer to Canon’s

web site.
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- Introduction

Downloading Images to Your Computer Erase dust shot with the image - p.61, p.63
Download images by connecting your cameraand 07 Erase unwanted parts of an image = p.65 Contents at
computer ' Reduce image noise - p.56 a Glance
Download images using a card reader -p.9 Correct lens aberration - p.57
— : Use a Picture Style file - p.53 o Be?zi(?on
Viewing and Checking RAW Images Edit efficiently -p3l P
Quickly enlarge parts of an image = p.1l Edit an image while comparing the image before and _, 0.49
Sort images (check marks) = p.17, p.18 after adjustment ' Advanced
Display an image _shot simultar_leous_ly as a RAW - p.20 Synchronize multiple images = p.50 Operation
image and JPEG image as a single image Display an area beyond the setrange asawarning .,
Display the images in the thumbnail list display at high _ 0.21 indicator (Highlight/Shadow warning) P Advanced
resolution ' Restore an adjusted image to its condition at the time  _, 0.39 Ir;naggﬁgtlit;]ngg
Check shooting information such as the shooting date =» p.10, p.21 of shooting '
L ) ] A Processing
Editing RAW Images (Adjusting) Printing Laggelr'::r;gsers
Adjust brightness/darkness =>p.12,p.24 » Print well on a Canon printer = p.39, p.68, p.69
Use automatic adjustment = p.30 Faithfull ; o
X y reproduce the color of the subject Editing
Change the Picture Style =>p.24 when printing =» p.39, p.68, p.69 JFI>EG/T|FF
' mages
agii?ggt)the modulation and contrast of colors =>p.27 @ Print with the shooting information =» p.66 g
Make skin tone look healthier (color tone) ->p.27 @ Printa thumbnail list of images = p.67 Ref
' i eference
Make the image colors more vivid (color saturation) = p.27 Qﬁr?tri?])élrrr;astjlttst]e color seen on screen with your ->p.74
Make an image sharp (sharpness) = p.29
Adjust an image to make color tone more natural :
(white balance) - p.25 Conversion Of Images | e
Change an image to black-and-white or sepia tones - D28 Convert a RAW image to a JPEG image = p.38, p.80 -
(monochrome) P Edit in Photoshop = p.65, p.81
Trim parts of an image (trimming) =*p.35 Perform batch processing - p.80 @ @
Specify an aspect ratio that matches the size of the 2035 Edit (adjust) a JPEG image ->p.84
paper on which an image is to be printed P @
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1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Click the Dock icon.

Digital Photo Profe ssio_nal

Click

DPP starts up and the main window ([Folder] window) appeatrs.

v

Main Window Display

In the main window, you can use tabs to select either the [Folder]
window or the [Collection] window. The [Folder] window displays the
images in folders on your computer, while the [Collection] window (p.33)
displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

Introduction
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[Collection] window
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Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, refer to p.45.

800 Digital Photo Profe

1113,
1113

Folder Collection(0)
v = MacOsX
P A Applications
[Z Temporary ltems
¥ [ B Users
v @ canon
» [@F Desktop
p | % Documents
» & Library
[® Movies
L& Music

» [ shared

Start up EOS Utility.
Select the [Tools] menu » [Start EOS Utility].

Tools
Start EOS Utility B

Il\;: | IJ 1 .Il'.'l' l-I L

EOS Utility starts up.
EOS Utility

)
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800 EOS Utility
Control Camera Accessories
Starts to download images
Lets you select and download images

Camera settings/Remote shooting

“ Monitor Folder
2
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Connect your camera and computer and turn the
camera on.
Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.
For detailed instructions on connecting your camera and
computer, refer to the “EOS Utility Instruction Manual” (PDF
electronic manual).

Accessories

Starts to download images

Lets you select and download images

Camera settings/Remote shooting

Monitor Folder

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-Z\@/i- Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

ﬁl You cannot start up EOS Utility in the [Collection] window
(p.6, p.33).
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Downloading Images Using Your Card Reader Display the images downloaded to your computer.

_ _ _ In the [DCIM] folder copied to your desktop, select the folder
You can also download images to the computer using a third-party card where the shot images are saved
reader. : Contents at
Digital Photo Professional a ance

Load the memory card into the card reader.

— ic
7V 8 Apptcatons Operfdtion
|- Temporary ltems
Y T;TS:km
”’ Advanced
L 12( IMG_0001.CRZ Operat'on
> 8 Aeares m Advanced
. . . L Image Editin
=» Images in the folder are displayed in the main window of DPP. am?primingg
Open aremovable disk icon in the folder area and
move the [DCIM] folder inside to a suitable place Processing
such as to the [Desktop]. R
806 Digital Photo Prof
= Editing
JPEG/TIFF
— Ma::l;:{er Collection(0) Images
"o Eifn'.‘fi,‘l?;’
¥ ¢ & caron
- F— Reference
’Sb =Q= Checking before downloading images
¥ [ Shared Index
T E— By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images. -
The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder. |§| Copying to your computer may take time when there is a large @ @
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of @
N

shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).



Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list Ch ang i ng the Size of Thumbnail Images

n the main W|_ndow. You_ can double-cllcl_< an image to open the edit You can change the size of the thumbnail images displayed in the main
window and display the image at large size.

Introduction

window and display them with shooting information attached. Contents at
a Glance
View Images as Thumbnails in the Main Window Select the [View] menu » desired item.
y
Rotate selected image Edit in Edit image window - Oper@tion
Main window ‘ View collections HG
[ i T Frofesaions T T Ve B v Tab
e  Folders
v Toolbar Advanced
Tool palette ®T Operation
Large thumbnail E
v Medium thumbnail 2
Small thumbnail 3 Advanced
Thumbnail with information 34 Ir;na(jggﬁgtlitll,]ngg
Sort »
» The display changes to the selected item. 1 aprgzcﬁjrﬂggr s
of Images
Editing
JPEG/TIFF
Images
Click to select the image
Display thumbnails of all the images inside the Reference
folder selected in the folder area on the left
Index
|§| When aspect ratio information is attached to the shot image with @
the EOS-1Ds Mark Il or EOS-1D Mark I, the image is displayed

as a trimmed image (p.35, p.92).

For a list of main window functions, refer to p.103. 10



Enlarge and View an Image in the Edit Window

The edit window appears.

v

Edit window

Double-click

Tool palette

%] Digital Photo Professional - [ MacOSX /Users) canon] Pictures  Photo xxo o IMG_0001 CR2 |

ana

(1374, 570 ): 244, 245, 244 High quakty

RAW | Adobe RCE CMYE

It may take time for the image to redraw itself.

Click the [@] in the upper left of the window to close the edit

window.

@ For a list of edit window functions, refer to p.106.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

B ) Digial Phote Professional - | MacOSX [Users.canon ) Pctune s Photo/xoo_xx_cx /WG 0001 CRZ |

e  — = — Double-click

[faa7a, 5703 24, 245, 200 High quaey.

AW | At BER O

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.

©® Double-click again to revert to the full view.

® To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

=Q= To display an image in an enlargement ratio other than 100%

Select the [View] menu » [200% view] or [50% view].

|§| You can change the enlargement ratio when you double-click (p.72).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [[ % ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
———{ Raw RGB  NRiens ——of
|Eﬂ'9hfﬂess adjustment [ _® |— Reverts the image to
@ e the orlglnal.settlngs
|wm e P i| rl?rﬂ? the slider left or
E 1] 2| 3 |C Register.. g
Shot settings B Tune.. )
|Picture Style i ::-L ;
Standard B ( Browse... )

- ]

h—-!D.U -80 -6.0 -40 -20 O 20 4.0

{cui:]lntrasl.' e S
[ Linear

g].lurturte: SR v S

Enllnr saturation: R B

?ﬂarpness: i R

The image brightness changes in real time according to the
amount of adjustments.

"2 The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.77).

ﬁl For a list of tool palette functions, refer to p.107.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Close window W
[ Save 365
Save As... ir 35
Convert and save... ¥D
Page setup... {1 3EP
Print... P
Print with detailed setting... 13D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... |

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.37)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.21)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.38)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process* (p.80)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

You can save * in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

Close window HEW
Save S
Save As... 1{r3S
Convert and save... ¥D
Page setup... it 3P
Print... 3P
Print with detailed setting... <{r3D
Contact Sheet Prints... ~ 3P
Plug-in printing >
Info... 4|

The [Print] dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.

-:\@/3 To change the paper size

To set the paper size etc., select the [File] menu » [Page setup].

Printing

With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.44)

Print using a Canon inkjet printer (p.39, p.42)

Print with a high-end Canon printer (p.68)

Print with shooting information (p.66)

Printing a thumbnail list (contact sheet printing) (p.67)

Quitting DPP

In the main window, select the [Digital Photo
Professional] menu » [Quit Digital Photo
Professional].

Digital Photo Professional

About Digital Photo Professional
Preferences... o
Services [
Hide Digital Photo Professional 36H

Hide Others “_##H

¢ Al

[ Quit Digital Photo Professional BEQ)

=» DPP quits.

"2 Quitting DPP without saving adjustments to images

A confirmation dialog box for saving the images appears. Select [Yes to
all] to save the adjustment contents (recipe) to all the images adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.................cco..... 16
SOorting IMAQES.......ovvviiiie et 17
Sorting Images in the Main Window ...................... 18
Arranging Images in the Main Window...................... 18
Arranging bY TYPE ...oovvviiiiiiiiiiiiiiiiieiiiiiiae 18
Arranging Freely ..........ovvvevvviiiiiiiiiiiiiians 19
Displaying a RAW Image and JPEG Image as a Single
IMAGE.....ci i ————————— 20
Improving the Quality of an Image in the Main Window ... 21
Checking Image Information............ccccevevvviiiiiineeeeene 21
Editing an Image ..ot eeianns 23
About the RAW Tool Palette..........ccceveveeiieieeiiiineee, 23
Editing with the Tool Palette in the Main Window.. 23
Adjusting Brightness .........coveiiiiiiiiiiiii e 24
Changing a Picture Style ...........ccccceiviiiie, 24
Picture Style File ... 25
Adjusting Color Tone by Changing White Balance.... 25
Adjusting Color Tone Using Click White Balance...... 26
Adjusting Contrast ............ceevveveveriviriiiiiiii... 27
Changing Color Tone and Color Saturation............... 27
Adjusting MoONOChrome...............eeevvvvvvveiieiiinieinennns 28
Adjusting Sharpness.........cccccciiiiiiiiiiieieee, 29
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) e 30

Editing Efficiently ... 31
Editing in the Edit Image Window...............cccccvvveeeen. 31
Changing the Thumbnail Display Position to a Horizontal
POSITION....uiiii i 33
Gathering and Editing Images in the Collection Window ... 33

Trimming an IMage.......cccooevvveeiiiiieeeeece e, 35

Applying Adjustment Contents to Other Images...... 37

Saving Editing Results............ccccceevievviiiiiiiieeeeeein, 37
Saving Editing Contents to a RAW Image.................. 37
Saving as a JPEG or TIFF Image.........ccccccvvvvvvvvvnnnnnes 38

Re-Editing an Image...........ccoovviviiiiiiiieeeciicie e 39

Printing an IMage .....ccooooovveiiiieieeeeiie e 39
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ......................... 39
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint............cccccoveevennnnnen. 42
Printing Photographs with a Printer other than the Canon
INKJEt PriNtersS.....ccooviiiiii e 44

Organizing IMages .......ccuveevieeeeeiiiii e 45
Deleting an Unwanted Image ............ccceevvvvviiieeeeeeennns 45
Creating a Folder for Saving Images...............ccceeee. 45
MOVING IMAGES ....eeeviiiiiiei et 46
Moving Images in Folders ..........cccoovvviiiiiiiiiieeeeeeeeas 46
Registering Frequent-Use Folders (Bookmark
RegIStration) ......ccoooeeeieeeeee e 47

Organizing Bookmarks ..........ccccvvviiiiiieeeciceiiin. 47
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into three groups.

Display the quick check window.
Select the [Tools] menu » [Start Quick check tool].

Tools

Start EOS Utility " EE
Transfer to Photoshop 3P

Start Quick check tool “3F ]

Start Trimming too BT
Start stamp too NaES
Start Rename tool 3R

Sync folder with EOS Utility

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.
Quick check window

2715 IMC_D002.CR2 (3456 x 2304]
view || Full screen

All the images displayed in the main window can be checked in
the quick check window.

Double-click the area you want to enlarge.

e 50 click

e

The area you double-clicked is enlarged to 50% view.

Double-click again to revert to the full view.
@ To change the display position, drag on the image.
® To quit, click the [OK] button.
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1/

> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <38> + <—> or
<H> + <> keys.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.72).

For a list of quick check window functions, refer to p.109.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

2715 IMC_0002.CR2 (3456 x 2304]

@ Click the [Clear] button to remove the check marks.
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

bs/Photo/xxxx_xx_xx ]

Check mark

o]

The selected check mark appears in the upper left of the image
frame.

Click the [Clear check] button to remove the check marks.

Vs

5@3 To select multiple images in the main window

Click on desired images while holding down the <3£> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window -
View collections NHG
v Tab
v Folders
v Toolbar
Tool palette #ET
Large thumbnail ®’1
¥ Medium thumbnail 32
Small thumbnail *3
Thumbnail with information 384

0 v File name
RAW priority

Check mark1
Check mark2
Check mark3

Shooting Date/Time

The images are arranged in the order according to the selected
item.
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Sort item Description

Check mark1 -
Check mark3

Images with check marks take priority and are
sorted in number order.

Images are sorted by shooting date and time
from the earliest.

Shooting Date/Time

File name Images are sorted by file name in alphanumeric
order (0to 9 » Ato 2).
RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.

-Z\@E Check mark order

When you assign check marks 1 to 3, the images are sorted as follows:
1 selected: 1»2-3
2 selected: 2-1-3
3 selected: 3—-2->1

Arranging Freely

Drag and drop the image to the desired location.

[ Digmal Phots Professional Fie [dn  iew

Bockmark  Adfionem Tooh Wndew Rep T wariim @

Lilalsl - [ M L |

— B oo s e e ot g 15 et A e
The image moves to the desired location.

® You can also select multiple images (p.18) and move them.

©® The order of rearranged images is maintained until you quit DPP
or select another folder in the folder area.

@ Select the [View] menu » [Sort] » [File name] to revert to the

order before the images were rearranged.

A/

5@3 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in Preferences to maintain
the order of images without changing the image file names (p.72).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.82).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Digital Photo Professional] menu »
[Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

-

Preferences

+ General settings l View settings lTaoI palette Color management -
—

Crid pitch
T B4 Pixels(8-256)

Locking selected image
@ Images opened in Edit window remain selected in main window
Magnification in Edit window

%) Fit to window ) 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

50% ® 100% ) 200%

' ™ Display only CR2 images for CR2 and JPEG files of the same name )

Sort order in main window

| Retain sort order

Highlight/shadow warning

Highlight 192 (s2-255 [
Shadow 0 (0-64) ]

Quick check tool display

) s0m ) 100% (mairé reduction off)

Cancel \ f 0K 3

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [ZXD] mark (p.105).

? RAW images with the extension “.CR2" can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF"
cannot be displayed as a single image.

E\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
 Deleting an image (p.45)

* Moving or copying an image (p.46)

» Checkmarks (p.17, p.18)

» Rotating an image (p.103, p.109, p.110)

» Attaching a thumbnail to an image and saving (p.21)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ X3B] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.104).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

Open in Edit window... #0
Open in Edit window (enlarged)...

Close all

Open window 3EN
Close window W
Save 3#£S
Save As {1385

( Add thumbnail to image and save {r3T ]

Convert and save... #£D
Batch process... ¥B
Create new folder... 138N
Page setup... {+3#EP
Print... #P
Print with detailed setting... {+ 3D
Contact Sheet Prints... ~HP
Plug-in printing >
Add to collection ®G
Remove from collection {+ 3G

AL/

5@3 The extent of the improvement in quality

The quality is improved for any RAW, JPEG or TIFF image. While the
image quality improves regardless of the thumbnail size (p.10), selecting
[Large thumbnail], with its larger display size, shows the improvement
more clearly than [Medium thumbnail] and [Small thumbnail].

|§| A large number of images may take some time to add.
You can specify a presetting for JPEG images to improve the
quality of all main window thumbnails (p.70, p.71).

Checking Image Information

Select the image for which you want to check the
Image information.

Select the [File] menu » [Info].

Open in Edit window... #O
Open in Edit window (enlarged)...
Close all
Open window 3N
Close window W
Save 35
Save As... {385
Add thumbnail to image and save {¥T
Convert and save... ®D
Batch process... 3B
Create new folder... 3N
Page setup... {r3EP
Print... P
Print with detailed setting... 4D
Contact Sheet Prints... ~¥P
Plug-in printing >
Add to collection ®G
Remove from collection {+#G
Delete

[ info... %l )

The image information window appears (p.22).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

[Metadata] tab sheet

& & & |# IMG_0001.CR2 & & 8 ¥ IMG_0001.CR2
—E Shooting Information | Metadata Shooting Information | Metad }
File name ™
IMG_0001.CR2 | Description )
Camera Model Name 1
Canon EOS oo | .
" | [Document Title]
Firmware \
XK ]
Shot date | [Author]
000 000K 300230010 | OO0
Tv (Shutter Speed) | [Author Title]
| XXANKHAXK
1/400 Sec. | [Description]
Av (Aperture Value) 1 OO
F13 : [Description Writer]
: XXANKHAXK
Metering Modes : [Keywords]
REER ) | XXANKHAXK
Exposure Compensation |
-2/3 | i
[Copyright Status]
150 Szp;;d : Public domain
L | [Copyright Motice]
ens ) XXANKHAXK
% [Copyright info URL]
Focal length |
17.0mm jl| [ oo
Image size |
KK X KHHK |
Image Quality 1
1
Flash !
on i
White Balance
HHHHAX
AF mode
HHHHAX
Ficture Style
HHHHAX
Parameters
Tone curve
Sharpness level
Pattern Sharpness -
Contrast -
Sharpness
Color saturation ‘
Color tone
Highlight tone priority v N 14
A o

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in

Photoshop CS3 after shooting is displayed in the [Metadata] tab

sheet. IPTC* information provides additional comments on

images, such as captions, credits and the shooting location. The

information is sorted into 5 different categories and can be

viewed by selecting [Description], [IPTC Contact], [IPTC Image],

[IPTC Content] or [IPTC Status] from the list box in the

[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

A/

> Convenient uses in the main window

A/

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnail with information] (p.10).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the [[ 5]
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette
B M A« Digital Photo Professional - [ MacOSX fUsers feanon /Pictures/ Photo) oo xxs(IMG_0001.CR2 | st == -*-::-tv‘m
4
T e
i =
Standurd Ir' Browns

(1374, 573): 248, 345, 244 High quakty

RAW [ Adobe RCB CMYVK

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3f> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.49).
You can synchronize multiple images and edit while comparing
them (p.50).

Refer to p.106 for a list of edit window functions, and p.107 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tools] button (p.103) in the toolbar on the main window,
the same tool palette that appears in the edit window is displayed and
you can edit images.
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Introduction

Adjusting Brightness Changing a Picture Style
Brightness of an image can be adjusted. Move the slider to the right to If the image you shot is different to what you visualized, you can change Contents at
make an image brighter and to the left to make an image darker. the Picture Style to get closer to what you envisaged. a Glance

Even if you have saved the image (p.37) with [Monochrome] (p.28)

————| RAW | RGB NR/Lens . selected, you can still change to another Picture Style at any point by
: - : Reverts the image to simply selecting a Picture Style other than [Monochrome]. Basic
[ e ([ ®= ||—the original settings Operation
s (- .
Tt Iml rirrrrennd I"}I:”:I _Enteranumerlcal P't 5 { H
tyl -
e 5] — (2] pevers e e
S 'jv-—_---J [ Standard Z J :]]I,'r Browse... ) Ad@ed
112 ] 37| register. . = 7 Select Opeiftion
Shot settings [ :] { Tune.. )
B Advanced
. . : i i 2 Image Editin
Drag the slider left or right . v a\n<§|JPrintingg
SV0.0SHI 5.0 -FOEEe.0 0 RO 40
:i‘ﬁntrasr: 1 1 1 1 V 1 1 1 1 ProceSSing
[ | Linear Laggfelr';lurgngsers
a
Color tone: =
{n] ur Dne 1 1 1 1 v 1 1 1 1
Caolor saturation: (? Editing
{u] 1 1 1 1 1 1 1 1
: JPEG/TIFF
{S{I]ETDI'IESS. T@ T g e L e St Images
Reference
Index

QO

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as @
the RAW image is compatible with DPP (p.3).

ﬁ' The adjustment range is 2.0 to +2.0 (in 0.01-stop increments when You can retain the [Color tone], [Color saturation], [Contrast] and

entering a value). [Sharpness] settings, even if you change the Picture Style (p.73). 24



Picture Style

Standard

Portrait

Landscape

Neutral

Faithful

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.27).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.28).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [].

Picture Style File

A Picture Style file is an extended function of Picture Style. It is a file that
offers effective image characteristics for an image shot in an extremely
limited scene. Refer to p.53 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

---------- —  Raw RGE | NRAens ——
|Eﬂ'ghrness adjustment = .|
:I:II!::'IIM:I:IIIII'II ':}DD
|White balance adjustment [. + |[—— Reverts the image to
7] P1 [%] s | Register the original settings
[I Shot settings | $]I Tune.. )
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.26).

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.27) to get closer to your
requirements.

® You cannot register the adjustment results as personal white
balance (p.79) when you have selected [Shot settings] from the list
box.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

QO

25




Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

———-f RAW | RGE  NRAens
|Erighmess adjustment = |
|||||||||IIFZIIIIIIIIIII G-DD
|White balance adjustment = |
> swma e R
i i i e Click
Shot settings | ::}[: Tune... :l

Click on a point that is to be the standard for white.

~ Dignal 7 x_xx/MG_DD10.CRZ Gaiakal = W BaiO P |
% = - - : SE—— — N Ty

—— =)

[P =

e
|
|

12290, 1285 ) 109, V16, 123 RAW | Adsbe BER CMVX

\
‘ Click Reverts the

The coordinates of the cursor position and the  image to the
RGB values (8-bit conversion) original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

| Picture Style

(= J—— Reverts the image to
the original settings

|¢]|," Browse...

5 4

Standard

r‘—-iI]_i] -8.0 -6.0 -4.0 -2.0 D 20 4.0 .
—— Drag the slider left or

{CUTL S U s ey right (9 steps)
 Linear

E;:].Iurturre: e 'QH? R

E:::Inr saturation: T v b

{S{l]arpness: 'I_@I e T

Display the value of the setting

-I\@/E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.24) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.28).

Q_?_N— Reverts the image to
the original settings

‘ Picture Style

Standard f :] [ Browse.. )

W e

3/

a0 o
Caontrast: -
{U]n 2 1 1 1 1 (? 1 1 1 1
R — Drag the sliders left
Colotin. ) rag tne sliders letrt or
{U] I i I |‘v,| 1 1 1 rlght
et , (T e
Color saturation:
(017 1 1 1 |t<:?’| 1 1 1
&h ¢
{]_]arpness 'l_@. 1 1 e I ('} 1
Display the values of the settings
Color tone: Mainly used for adjusting skin tones. Move the

slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).
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Introduction

Adj usti ng Monochrome Filter effect: Creates an image where the white of clouds and the

When the Picture Style (p.24) is set to [Monochrome], you can create green of trees are emphasized in the same
monochrome photograph.

monochrome photographs with effects similar to filtering and with the Contents at
look of a single-color photograph. Filter Example of effect a Glance

Select [Monochrome] in the [Picture Style] list box None Ordinary monochrome image without filter effect.

. . Basic
(p.24). vellow Blue sky is reproduced more naturally and white Operation
clouds emerge clearly.
[l =)— Reverts the image to Orande Blue sky becomes somewhat darker. The
T ) ( Browse... ) the original settings 9 brightness of the setting sun increases further. ég%gﬂ
g . Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
' _ Advanced
Green Human skin tones and lips become softer. The Image Editing
o green leaves of trees become clear and bright. and Printing
G A O MO e
Conbast TS, RN Toning effect: You can create a single-color monochrome Processing
(] biwar , photograph to which color has been added. Large Numbers
Filter effact ) Drag the sliders left or You can choose from [None], [Sepia], [Blue], [Purple] orf Il =
G 1 1 1 1 H
{None) e right and [Green].
Toning effect: 6 Editi ng
il JPEGITIFF
i ey Images
Display the values of the settings
Reference
Index
== Increase the [Contrast] to emphasize the filter effect @

To emphasize the filter effect, set the [Contrast] (p.27) slider closer to
the right. o8



Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.
Move the slider to the right to make an image harder and to the left to

make an image softer.

| Picture Style

[[EJII— Reverts the image to

Standard

| #] ( Browse... :I

"

4

100 -80 -60 -40 -0

Caontrast: r
{U] I 1

| Lingar

Calor tone:
{0] 1 1

Calor saturation:

{0 1 1

Sharpness:

{:!_] @IIIIIIII

Display the value of the setting

the original settings

!
Drag the slider left or right

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness may seem unnatural.

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired

automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
——— raw || reB || NRiLens
\Tcm curve assist [0 | [+ | @5 —— Reverts the tone curve
Tone curve adjustment [ | to the original settings
e R [ c | s |
7 : .
255 High
Standard
D p 1
o] 255
EﬁghTHESS: LYy DE
cuntrasr- trrnrrrereYreerrrrene D?
Hue et |3! DE
saturarlun e rereYrerrernne |bi ll:”:l z
Sharpness: @—ibl 0 ?

The tone curve changes as adjusted.

~@= Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

« Images which have extreme backlighting

(D It you click the [(E25]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.88).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

EC

ct all Clear al

Sel

Click

The main window switches to the edit image window.

Edit the image.
Change the size

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

=» It may take time for the image to redraw itself.
The same tool palette as in the edit window is displayed and you
can edit the image.
To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <3f> +
<Z> keys.
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Double-
click

A | i 058 CTE

{5 T8 00 T 48 gt ussny

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view ([Fit to window]).

To change the display position, drag on the image or drag the
enlargement display position (p.107) of the tool palette.

To return to the main window, click the [Main Window] button on
the toolbar.

A/
~

Q-

To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.73).

You can change the enlargement ratio when you double-click
(p-72).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.33).
For a list of edit image window functions, refer to p.110.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

I Photo Professional File Edn  Wiew  Adjustment  Tools Window Help 41 Wed 1117 AM @
# Digital Photo Professional - [ MacOSX/Users /canon/ Pctures/ Photo/ xxxx_xx_xx, /IMGC_0000.CR2 |

AW { Adsbe BEB CMVE

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing
you to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

Open in Edit window... #O
Open in Edit window (enlarged)...

Close all

Open window N
Close window W
Save #S
Save As... 1+ 35S
Add thumbnail to image and save {+3T
Convert and save... #D
Batch process... 3B
Create new folder... {r3EN
Page setup... {r3EP
Print... P
Print with detailed setting... G ¥D
Contact Sheet Prints... ~HP
Plug-in printing >

( Add to collection ®G ]

Remave from collection 3G

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.20), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, clicking on the image while holding down the <control>
key, and selecting [Add to collection] from the menu that appears.
You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

Edit image
window

Folder
v =4 MacOSX

- A Applications

[7 Temporary Items

¥ L& Users :

¥ @ canon "

The selected images are displayed in the [Collection] window.

Check displayed images in the [Collection] window.

@  Digital Phato Professional  File Edit View Bookmark  Adjstrunt  Tooks Window  Help w4 Weda0ira @

Hiagh quairy Racigs data Yea P of images 15 Pearniser o selectd images. | e i

Edit the images.
You can now edit the images displayed in the [Collection]
window.

=Q= To remove images from the [Collection] window

Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, clicking on
the image while holding down the <control> key, and selecting [Remove
from collection] from the menu that appears.)

Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

® Images brought together in the [Collection] window are

retained until you quit DPP
When you quit DPP, the gathered images disappear from the
[Collection] window, but this removal from the [Collection] window
does not mean that the original images themselves have been
deleted.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window
are all applied to the original image.

|§| You cannot use the following functions in the [Collection] window.
» Starting of EOS Utility (p.7), or synchronizing of folders with EOS
Utility
» Batch change the file name of images (p.82)
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark lll, the trimming range based on the
aspect ratio information is displayed.

Select the image to be trimmed.

Open the trimming window.
Select the [Tools] menu » [Start Trimming tool].

Start EOS Utility 3B E
Transfer to Photoshop 3P

Start Quick check tool “C3F
[ Start Trimming tool T )
Start Stamp tool 3RS

The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.
Trimming window

Y = 1/1 MG 0001.CR2 [3456 x 2304]

Select a
G e 2 trimming
"""" ©  ratio

T Drag the
~— = trimming
range

(TGN 50415 3026, 1ENO ) = (1969 x 132611 190

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

A Click the [OK] button to return to the main window.
“" < The trimming range frame is displayed in the trimmed image
(p.105).
When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its trimmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.39).

Display of the trimmed image in each window

» Main window: The frame showing the trimming range is
displayed on the image (p.105).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.38).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark lll, the set trimming range based
on the aspect ratio information is displayed. However, since the image
is not actually trimmed, you can change the trimming range or revert
to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

~
-

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]

menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe to
selected image].

The recipe is applied to the image.

|§| The recipe (p.77) can be saved as a separate file from the image
and loaded and applied to another image (p.78).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.35) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.52 to p.57) and the dust
erase processing explained in Chapter 3 (p.61 to p.65) can also be
saved in a RAW image.

Select the [File] menu » desired item.

Open in Edit window... #O
Open in Edit window (enlarged)...

Clase all

Open window 12 N

Close window HEW
Save 35

Save As... 135S

Add thumbnail to image and save {r3T

Convert and save... HD
Batch process... #B

Create new folder... 3N

Page setup... {r3EP

Print... 3P

Print with detailed setting... 4 ¥D
Contact Sheet Prints... ~HP

Plug-in printing >
Add to collection ®G

Remove from collection {+#G

Delete <&
Info... #l

Your adjustments are saved to the image.
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)

Introduction

Saving as a JPEG or TIFF Image Specify the necessary settings, and then click the
To vi dit and print a RAW i ith soft ther than DPP. [Save] button.
0 view, edit and print a image with software other than : : , :
convert to a more versatile JPEG or TIFF image and save. By default, the image is converted and saved to a JPEG image Sl el
with the highest image quality, without changing the image size. a Glance

The image is saved as a separate image, so the RAW image remains

Change the settings according to your requirements.

unaffected.
Convert and save
] Basic
Select the image to be converted. ((save as: ore_oo01 @ }—{— Enter a file name Operation
( where: (75 Photo ) }—+— Select the save
: destination
Select the [File] menu » [Convert and save]. Lie format _ Advced
(Kind o file Exif-JPEC w:])—— Select an image type Op g
Image guality v A9 YU a 10
Open in Edit window... FO Output seydll
Dpen in Edit window (enlargEdJ“‘ Output resolution ﬁdpi O E;d ICC prafile Advanced
Close all o
:'n-.-r e N Resize setting N Image Editing
pen winaow - | Resize j i
C[OSE window HEW Width Height Unit. = and Prlntlng
3504 x 2336 pi‘:-l__
{3504 pixel ) {2336 pixel )
Save ggs f L:t\:.spetlwfi: X i
Save As... {+ 385 LPFOCSSSItI;]g
Lo (Cancel) [ s )}—— Click and save ag%elm:g]esers
Convert and save... #ED
Batch process... #B =» The RAW image is converted to a JPEG or TIFF image which is -
Create new folder... T %N then saved as a new image in the specified save destination. JFI’ESCI;/I!IIPFF
Page setup... {r38P Images
Print... #EP
Print with detailed setting... 3D
Contact Sheet Prints... ~¥P Reference
Plug-in printing >
Add to collection HG
Remove from collection {+3G
Delete el Index
Info... £ |

The [Convert and save] window appears.

dust-erased image explained in Chapter 3 (p.61 to p.65) actually

becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which @
occurs when you convert and save an image as a JPEG (p.70).

You can batch convert and save multiple images (p.80).

For a list of [Convert and save] window functions, refer to p.111.

ﬁl By saving as explained on this page, a trimmed image (p.35) or @ @
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.23), so the “original image data itself’ remains
unaffected.

Also, the trimming range information of a trimmed image (p.35) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.37) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left 3L
Rotate Right 3R
Add check markl H#F1
Add check mark2 HF2
Add check mark3 HF3
Clear check mark I F4
Work color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings 3#Z
Revert to shot settings ~37

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with the Canon inkjet printers compatible with the Canon printing
software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how
to print photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.42)
Printing Photographs with a Printer other than the Canon Inkjet
Printers (p.44)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint EX
(hereinafter, “EPP EX”) :
Simple printing of RAW images
Printing with faithful colors
® High gquality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.

Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

Open in Edit window...

Open in Edit window (enlarged)...
Close all

Open window

Close window

Save

Save As...

Add thumbnail to image and save
Convert and save...

Batch process...

Create new folder...

Page setup...
Print...
Print with detailed setting...
Contact Sheet Prints...
Plug-in printing

Add to collection
Remove from collection

EPP EX starts up.

#0

#EN
HEW

#5
1 38S
38T

F*D

F*B

{+3EN

{r 3P

P
{+ 3D
~3P

#G

Print wnh Easy—thnPrlm EX

%G ‘

In the EPP EX window, select the [File] menu »

[Preferences].

My Recent Files >

Next Step

Preferences...

The [Preferences] window appears.

In [Print Quality], select [Quality Prlorlty]

Amount of extension of borderless printing Default

; Copies

6 0.0 Preferences
Print Advanced
Number of copies : 1
Printing Order By Date

-

Print Quality

( Qu ality Prlcnrm,I

7)—— Select

¢ Optmn . )

Quality
Priority

-_: Defaults )

(“Help ) (

€

ancel ) ( 0K )

Click to close the window

Specify the number of sheets to be printed, and then

click [Select Paper].
EPP EX

G i P Pt iy PaiaP R B

Pheot Pring

o E - E“‘
(@ sescrraper |

ST
Exit

B
u

Exif Print
L2 -
e
=e | EE)—==5— Click to
q_ increase the
~~~ B nhumber of
Sae g ot s sheetsto be
printed
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Select the paper type, and then click the [Layout/

Print] button.

anA Mew Phota Print - Easy-PhatoPrint EX

‘Sabect e Drinier 13 s, Tien Select The SiTe AN 1De 0 Sager 10! DrNENG
Pheoto Pring

Casan 10K

Latien
5

Exi Print

Help. |

Click

|————Select the
paper size
and type

Specify the layout, and then click the [Print] button.

—_— __
anA Bew Phata Print - Easy-FhotoPrint EX

i Pt

Help. |

[ |

Click to print
Printing begins.

Select the
layout

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [Easy-PhotoPrint
EX] menu and then click the [Advanced] tab in the [Preferences]
window to display the [Advanced] tab sheet. In the [Advanced] tab
sheet, select [Enable ICC Profile] in [Color correction for printing] and
print using the [Perceptual] setting (p.118).

Y

- Advantages of printing using EPP EX

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).
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Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint (hereinafter,
“EPP"):

Simple printing of RAW images

Printing with faithful colors

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer.

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint].
Open in Edit window... *0
Open in Edit window (enlarged)...
Close all
Open window #EN
Close window #EW
Save 3#ES
Save As... i3S
Add thumbnail to image and save 3T
Convert and save... #D
Batch process... £
Create new folder... 1 38N
Page setup... {r 3P
Print... #P
Print with detailed setting... {+3D
Contact Sheet Prints... ~¥P
" D g Print with Easy-PhotoPrint  38E
Add to collection #G
Remave from collection {+#G

EPP starts up.

In the EPP window, select the [Easy-PhotoPrint]
menu » [Preferences].

Easy-PhotoPrint

About Easy-PhotoPrint...

(

Preferences... %, )

Services »>

Hide Easy-PhotoPrint 3H
Hide Others EH
Show All

Quit Easy-PhotoPrint  3Q

The [Preferences] window appears.

4 In [Print Quality], select [Quality Priority].

Preferences

e A |

Print Number of copies : 1 ‘3 Copies
Printing Order : | By Date | :}
Amount of extension of Default | :v]

borderless printing :

Print Quality :

[ ' Quality Priority

( Defaults )
Cancel ) E—Oﬁ-—)

M }——— Select

Quality
Priority
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Select the [Advanced] tab sheet and check that the

EPP image compensation function is disabled.

@ If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color
reproduction.

Preferences

[ e )
{ Print | Advanced
Image " JOptimize images automatically If _CheCked’
Apply Rotate /Trimming to the same images in the same manner CIICk to
When landscape images are rotated depending on the selected remove the
® Rotate Left check mark

) Rotate Right

Layout ] Always trim when you select the layout with the margins

ESet margins to the minimum when you select the layout
with the margins

E Print filename when you select the index in layout

E Preview all layouts of A4 and Letter

Image ] Select images from multiple folders .
Selection CIICk to

close the

( Defaults ) WlndOW

@ Cana O (o)

Specify the number of sheets to be printed, and then
click [Next].

Click

Click to
increase the
number of
sheets to be
printed

Check that the image compensation function is
disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

866 Easy-PhotoPrint

EﬁiﬁhhtoPrim

Select the
paper type

Pomsber of irowpa 19 P Sibe : A4 Podia Ty s Pt P Pro 19 Pagsia)

Click to print

Select the layout

=» Printing begins.
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? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
The printed image’s color is not what you expected

Change the [Rendering intents when using Easy-PhotoPrint] (p.74) to
[Perceptual] (p.118) and print.

AL/

Q> Advantages of printing using EPP

Printing with faithful colors

When the color space (p.118) is set to SRGB or Adobe RGB (p.65,
p.74), this color space is automatically transmitted from DPP to EPP,
allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.68).

Printing Photographs with a Printer other than the Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

Open in Edit window... H*O
Open in Edit window (enlarged)...
Close all
Open window N
Close window HW
Save *HS
Save As... {35
Add thumbnail to image and save {#T
Convert and save... ®D
Batch process... #B
Create new folder... 13N
Page setup... 1+ 3P
( Princ.. #®P )
Print with detailed setting... 3D
Contact Sheet Prints... ~¥P
Plug-in printing »
Add to collection #G
Remave from collection 3G
Delete E R
Info... 9|

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [Print] button.
Printing begins.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

Open in Edit window... #0
Open in Edit window (enlarged)...
Close all
Open window #EN
Close window HEW
Save 35
Save As... {+ 385
Add thumbnail to image and save (3T
Convert and save... ®D
Batch process... ¥B
Create new folder... 1 38N
Page setup... {+ 3P
Print... #EP
Print with detailed setting... {+3D
Contact Sheet Prints... ~¥P
Plug-in printing [ 3
Add to collection #G
Remave fram collection 1+ 3G
[ Delete %= )
Info... Eq]

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.

Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new

folder is to be created.

806 Digital Photo Profi

(I3}
i1

Folder Collection(0)
¥ =4 Macosx
» |4 Applications
[F Temporary Items
¥ (& Users
¥ 8} canon
» [@ Desktop

» % Documents
» (@ Library

[# Movies

& Music

> [ Sites
P |7 Shared

) Select the [File] menu » [Create new folder].

o e |

Open in Edit window... ¥0
Open in Edit window (enlarged)...

Clase all

Open window 3N
Close window EW
Save 3#S
Save As... )
Add thumbnail to image and save {r3T
Convert and save... D
Batch process... #B

( Create new folder... TN )

Page setup... {+3EP
Print... 3P
Print with detailed setting... 3D

The dialog box for entering a folder name appears.

Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images

Introduction

Contents at

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <option> key
and release when the image is in the destination
folder.

Digital Photo Professiona)

Folder
¥ = Macosx
b [A Applications
[ Temporary Items
¥ [ ¥ Users
v & canon
¥ [@E Desktop
| Travel
» [ Documents
P ¥ Library
[ Movies
¥ Music
¥ |2 Pictures
v [4 Photo
[0 ook _xx_xx
» (& Public
P [ sites
» [3 Shared

The images are moved or copied to the destination folder.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the Basic
Operation

Advaficed
Op ion

destination folder.
To copy: Drag the folder while holding down the <option> key

and release when the folder is in the destination folder.

— Digital Photo Professional

¥ 2 MacOsx
» A Applications
(¥ Temporary ltems
¥ & Users
¥ @ canon
¥ [ Desktop
[ Travel
» [ Documents
» |# Library
[® Movies
L8 Music

T TORKK

» [ & Public
» [ Sites
» [ shared

=» The folders are moved or copied to the destination folder.
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o Introduction
Organizing Bookmarks

. . You can change a folder name or delete a folder registered in
You can register frequently used folders in bookmarks. [Bookmark]. Contents at

Registered folders appear by clicking the [Bookmark] menu. a Glance

Registering Frequent-Use Folders (Bookmark Registration)

Select the folder for which a bookmark is to be

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change

registered. folder names or delete folders. OpBe?thfon
000 Digital Photo Professional
=
Advaficed
— Ma:;::r Ca\le(u:m(m Op |O ]
g LA :::'l‘;-;:;‘:: \Slems
77 & eanen
¥ @ Desktop Advanced
> (8 Documeres Image Editing
e @ ... and Printing
N ___ Select Processing
o~ - Large Numbers
» [F Shared . o w—-_f-—' Of |mageS
Select the [Bookmark] menu » [Add]. Editing
The folder selected in step 1 is registered in the [Bookmark] JPEG/TIFF
menu. Images
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.
Reference
Index
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3 Advanced Image Editing and Printing e

Introduction
Various preferences including advanced image adjustment, automatic Performing Automatic Dust Erasure Processing _____ 61
dust erasure processing, various printing functions for printing out work, ;
s e marr:agementgare epraiF:]ed hgre, eored © tF:]e usgr e Compat.lble Cameras............... ..... s s 61 Cg,gle;ntgeat
competent in the handling of third-party image editing software. Automatic Dust Erasure Processing in the Main Window... 62
Manually Erasing Dust (Repair Function)................ 63
Adjusting While Comparing with the Original Image... 49 Erasing Unwanted Parts of an Image (Copy Stamp OpBe?Zitfon
Changing How the Window is Split.............ccccvvveee.n. 49 FUNCLION).....eiiiiiiiiiiecc e 65
Adjusting by Comparing Multiple Images................. 50 Transferring a RAW Image to Photoshop................ 65 Advanced
Displaying an Area Beyond the Set Range as a Setting Work Color SpPace.............cccceeueuereueveuenennnss 65 (oo
Warning Indicator (Highlight/Shadow Warning) ....... 51 Printing with Shooting INformation...............cccccve.... 66 IV
Performing Advanced Editing............cccc.ccooeiviennne, 52 Printing 2 Thumbnail List (Contact Sheet Printing).. 67 Ignagagtiit;]%g
Adjusting White Balance with Color Temperature ..... 52 Printing RAW Images on a High-End Canon Printer.. 68
Tuning White Balance with Color Wheel ................... 52 Printing with a High-End Canon Inkjet Printer ............ 68 Lal:\)rzgoecﬁjrﬂggrs
Adj:usting .Dynamic Ran.ge ......................................... 53 Printing with a Large-Format Canon Printer .............. 69 of Images
_Lszmg a Plcture. Style File......ovvveiiiiiiii s 53 SDECIYING PIEfEIENCES..ovvvvrroooooooooeooeoooooeeoeeoooooe 20 W
ONe CUNVE AQJUSIMENL .ovvvrsscvvrersveeress s R o4 General SEttiNgS.............c.cveveveveueueeeeeeeeeeeeeees s, 70 | JPEG/TIFE
Example of a Tone Curve Operation .................... o3 VIEW SEtNGS..cviiiieee e 72 ot
About the RGB TOO! PAISTE ..vvoooooooooooceeeeen R >4 TOOl Palette ... 73
REdUCING NOISE ..o o6 COlOr MaNagEMENT ..........cccveveveeeeeeeeeeeeeeeeeesee e, 74 [ RS
Correcting Lens Aberration ..........cccooeevvviieeiiieeeeennnn. 57
Compatible Cameras.........ccccevvvviiiiiiiiiieciiccie e, 57 Index
About EOS 5D Compatible Lenses ...........ccccceuuee. 57
About EOS 30D Compatible Lenses ..................... o7
Compatible LENSES....cccoeeeiiiiiiiiii 58 @ @
Making COrreCtioNS............evvvvvuviviiiiiiiiiiiianns 59
About Shooting Distance Information Slider.............. 60 @
Correcting Multiple Images ata Time..........cccoeeeeee.. 60
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

| s a1 1o sty

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.
Select the [View] menu » [Change up/down/left/right] » [Up/
down].

[ZXal5) Dagral

s oo 7w 117, v i

The layout of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] » [Split single image].

T T T e T T

=» One image is divided and displayed on the left and right or top
and bottom.
To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Ad ced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

QO
©

49




Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and Move the display position.
adjust images while comparing them with each other. If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
In the edit window, display the multiple images to be other edit windows.
compared. To cancel synchronization, select the [Window] menu »

Align the images [Synchronize] again.

Align the images for easy comparison.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

W Dvgital Fhoto Professional e ew  Adpstmers Toshs Wandew o W 4 WedsiiR @
Ann - Er——

— ]

o ity i Ak S 20

: S gusine l‘“‘“w

The other edit windows will also be displayed in the same
position/enlargement ratio.

|§| Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the

Introduction

image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Corg}tlents at
in red and the shaded part in blue. [Shadow]. ablance
On the opened image, if there is an area that exceeds the value
Select the [Digital Photo Professional] menu » entered in step 3, the highlighted part of that area is displayed in Basic
[Preferences]. red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
Operation

Enter the warning value for [Highlight] and [Shadow].

-

Preferences
Advapced
- Ceneral settings View settings | Tool palette Color management - Imag |t|ng
and Pfinting
Grid pitch
" b4 Pixels(8-256)
Processing
Locking selected image L N b
E Images opened in Edit window remain selected in main window argfel umbers
ol Images

Magnification in Edit window g

®) Fit to window O 50% O 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked — J PEEdg/I_T_IgFF

O 505 100% ) 200%

© Images

RAW and JPEG
# Display only CR2 images for CR2 and JPEG files of the same name

Sort order in main window
__| Retain sort order Reference
Highlight/shadow warning
Highlight T 192 | woz-zss
Shadow B ) |

Quick check tool display Index

) 50% ) 100% (moiré reduction off)

Cancel \ f 0K ')

Click the [OK] button to close the window. @@

51

@ You can also display the warning with the same operation in the edit
image window.



Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens] tool palette
are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

———————— [ raw RGE NRiLens ————
‘En’ght‘ness adjustment = |‘

:I!II!II'IIE:I!II'II'II QDD
‘While balance adjustment | = |‘

I?‘ 2 ' 3 Register...

Color temperature | :] Tune... \I
o .
= (5200 k)—+— Display the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

enn White balance fine adjustment
Color tone: —— Enter the values
Color saturation: to set
Cancel DN - OK )
|
Drag

@ To register adjustment results as personal white balance (p.79),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).
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Introduction

Adjusting Dynamic Range Using a Picture Style File
Dynamic range (width of gradation expression) from dark points to bright A Picture Style file is an extended function of a Picture Style.
points in an image can be adjusted. With DPP, you can apply to RAW images Picture Style files that you Cgrg}tleanr}geat

have downloaded from Canon'’s web site effective for various scenes or
e — Picture Style files created with “Picture Style Editor”. When using a
| = '-—-:I!| Move downwards Picture Style file, save it to your computer beforehand. Basic
et L Bromse. Output highlight points _ . _ : — Operation
: : Display the image to which the Picture Style file is to

5

be applied in the edit window (p.11).
- : Move to the left or right PP (p-11) Advanced
Input highlight points Select the [RAW] tab sheet in the tool palette, and SEeTalien
e e click the [Browse] button.
ontrast: Sty ld 7 Ad ced
{cm_t l e e P b E) Imag\aji_ting
__| Linear Move upwards e Wl rowse.. ) and Pfinting
Calor tone: e Output shadow points = =
(0 Lo il i
Color saturation: 1 Processi ng
() SR e : / Large Numbers
h : : { of Images
{Sl]arpness T@ ot e e oy B ot Bt | b p . : g
' 105 5.0 560 40 -Zl.ﬂ R Editing
:\/lOVte tﬁ tze left (_)rtrlght JPEG/TIEE
nput shadow points =» The [Open] dialog box appears. Images
The horizontal axis shows the input level and the vertical axis 2 Select a Picture Style file saved on your computer,
shows the output level. and click the [Open] button. Reference
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again. Index

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will

display correctly. 53
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] Introduction
Tone Curve Adjustment Make adjustments.
v di he briah d color of i b Batch adjusts RGB
ou can adjust the brightness, contrast and color of a specific area by Adjusts each channel Contents at
changing the tone curve (p.117). Gl
——+— raw || RGB | NRALens | - alance
In the tool palette, select the [RGB] tab sheet. e A
Tone cprve adjustment = Basic
. _ D e T — Operation
Select the tone curve mode and interpolation - I C“J '.f""_!, i
method. o
[ RAW [RGB NRiens | gd\é?gt(i:gﬁ
|Tnne CUrVe assist e % P
Tone curve adjustment ]
B 5 : . Advapced
PR ko] 7] ' : Click to add a [OJ] (point) |ma93mmg
255 ‘ Adjust by dragging [[] and Pfinting
Processing
! Large Numbers
v Curve of Images
straight o o ' 48 B |
<control> + click inside 0 255 Editing
s the graph to display the piangesd® @ O( JPEG/TIFF
W menu Cﬂntraﬂ IIII'iIIIMI-I:I:III D -\Er Images
Hue .III.IIIIMI!III'II! 3 D 'i:
Saturation: m o ﬁi Reference
0 e
ey =/ Shi : [ =
0 255 sl SO .2, o Sl
: —_—— [] . . . . .
Brightness: T o O The horizontal axis shows the input level and the vertical axis
Contrast Ao~ e o shows the output level. Index
i (] " 3] The maximum number of [[]] is 8. R
S (5] 100 (% To delete a [[]], double-click on the [[]].

- g . Nal
Sharpness \IJ;HIIIIII!IIIIII!III 3 I:l-\::- @@

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any @
adjustments (p.73). o’
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.73). 54



Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones harder

Makes tones softer

/)

About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore we recommend for functions other than tone
curve adjustment and automatic adjustment (p.30), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens] tool palette (p.108) when
reducing noise (p.56) and correcting aberration (p.57) after you have
made any required adjustments with the [RAW] and [RGB] tool palettes.
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Reducing Noise

You can reduce noise that arises in RAW images that have been shot at
night or with a high 1SO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/Lens] tab sheet from the tool palette
in the edit window or edit image window.

Adjust an image.

RAW = RGB |

NRjlens |

= |

RAW
Luminance naoise

{0) 0 @ R N SR SR R 10
Chrominance noise
{U] o { S G T e AT e B | 10

Drag the sliders right

TIFF or JPEG
Luminance naise —
)] 0 10
Chrominance noise —
)] 0 10
Apply NR
Lens aberration correction Tune... |
Peripheral illumination OFF
Distorticn OFF
Chromatic aberration OFF
Calar blur OFF

You can set a noise reduction level from within a range of 0 to 10.
The larger the setting, the larger the noise reduction effect.

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view].
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it may be difficult to
check the noise reduction effect.

"2 Additional information

5

The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.70) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

To check the noise reduction effect, enlarge the image and
display it

Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the
noise reduction.

Luminance noise reduction is not available for SRAW images
You can only reduce chrominance noise for SRAW images. You
cannot reduce luminance noise.

If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.

If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in Preferences (p.73). This is particularly useful
for applying noise reduction to all the images in a folder at once,
such as batch noise reduction for images with high ISO speeds.
However, where images have a recipe attached, the noise level
recorded in the recipe is applied.

For a list of tool palette functions, refer to p.108.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which you have
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1Ds Mark 111 EOS-1D Mark 1l EOS-1D Mark II N

EOS-1Ds Mark Il EOS-1D Mark I EOS-1Ds

EOS-1D EOS 5D EOS 40D

EOS 30D EO.S DIGITAL REBEL EQS DIGITAL REBEL
XSi/450D XTi/400D DIGITAL

EOS 1000D — —

About EOS 5D Compatible Lenses

For images shot with the EOS 5D whose firmware version has been
changed to 1.1.1, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.1.0 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.5 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L 1l USM EF 200mm /2L IS USM
EF 16-35mm f/2.8L Il USM EF 70-200mm f/4L IS USM

Lenses not compatible with firmware version 1.1.0
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 200mm /2L IS USM EF 16-35mm f/2.8L Il USM
EF 70-200mm f/4L IS USM —

About EOS 30D Compatible Lenses

For images shot with the EOS 30D whose firmware version has been
changed to 1.0.6, the aberration correction function can be used with all
lenses under “Compatible Lenses”.

However, for images shot with version 1.0.5 or earlier, the following
lenses are not compatible.

Lenses not compatible with firmware version 1.0.4 or earlier
EF 14mm f/2.8L Il USM EF 50mm f/1.2L USM
EF 85mm f/1.2L Il USM EF 200mm /2L IS USM
EF 16-35mm f/2.8L Il USM EF 70-200mm f/4L IS USM
EF-S 18-55mm /3.5-5.6 IS EF-S 55-250mm /4-5.6 IS

Lenses not compatible with firmware version 1.0.5
EF 14mm f/2.8L 1l USM EF 200mm /2L IS USM
EF 16-35mm f/2.8L Il USM EF-S 18-55mm f/3.5-5.6 IS
EF-S 55-250mm f/4-5.6 IS —_—
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Compatible Lenses

Ultra wide and wide lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L 1l USM
EF 20mm /2.8 USM EF 24mm f/1.4L USM
EF 24mm /2.8 EF 28mm /1.8 USM
EF 28mm /2.8 EF 35mm f/1.4L USM
EF 35mm /2 —

Standard and medium telephoto lenses
EF 50mm f/1.2L USM EF 50mm f/1.4 USM
EF 50mm /1.8 EF 50mm /1.8 Il
EF 85mm f/1.2L USM EF 85mm f/1.2L Il USM
EF 85mm /1.8 USM EF 100mm f/2 USM

Telephoto lenses

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm /2.8L USM
EF 300mm f/2.8L IS USM
EF 400mm f/2.8L IS USM
EF 400mm /4 DO IS USM
EF 600mm f/4L IS USM

EF 135mm /2L USM

EF 200mm f/2L IS USM
EF 200mm f/2.8L Il USM
EF 300mm f/4L IS USM
EF 400mm f/5.6L USM
EF 500mm f/4L IS USM

Macro lenses
EF 100mm /2.8 Macro USM EF 180mm /3.5L Macro USM

Zoom lenses

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 24-70mm f/2.8L USM

EF 28-70mm f/2.8L USM

EF 28-200mm /3.5-5.6

EF 28-300mm /3.5-5.6L IS USM
EF 70-200mm f/4L USM

EF 70-200mm f/4L IS USM

EF 16-35mm f/2.8L Il USM

EF 17-40mm f/4L USM

EF 24-105mm f/4L IS USM

EF 28-135mm 1/3.5-5.6 IS USM
EF 28-200mm /3.5-5.6 USM

EF 70-200mm f/2.8L USM

EF 70-200mm f/2.8L IS USM

EF 100-400mm f/4.5-5.6L IS USM

EF-S lenses

EF-S 60mm /2.8 Macro USM
EF-S 17-55mm /2.8 IS USM
EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 IS

EF-S 10-22mm /3.5-4.5 USM
EF-S 17-85mm /4-5.6 IS USM
EF-S 18-55mm {/3.5-5.6 I
EF-S 18-55mm {/3.5-5.6 Il USM
EF-S 55-200mm f/4-5.6 IS

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced

Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

QO

58



)

Introduction

Making Corrections Checkmark the items to be corrected.

enNnn ens aberration correction - IMG_1001.CR2]

You can make corrections to any of the four aberrations as below, either

one at a time or simultaneously. Contents at

. . o a Glance
Peripheral illumination
Distortions
Chromatic aberration (color fringing which occurs in the periphery of Basic
an image) Operation
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Advanced
Operation

In the tool palette, select the [NR/Lens] tab sheet.

Click the [Tune] button. |mg33§ietidng
—————— RAW RGB | NRflems and Pfinting
|N:AW | < The image is corrected and redisplayed. Processing
' Check the results of corrections to peripheral illumination or Large Numbers
Luminance naoise A . i : of Images
o) T o TR distortions in the full view.
_ _ © Check the results of corrections to chromatic aberration and color Editing
fu';"”"'““““ TR iy blur by clicking the area on the image you want to check. In the JPEG/TIFF
top right of the window, the area is displayed at 200% in the Images
TIFF or JPEG enlargement display section (p.113).
{La:]minance noise I You can Iessen the degree of correction by moving the slider to
the left for the item you want to correct. Reference
Chrominance noise ~ — You can respectively correct red chromatic aberration with the [R]
" . - slider of the [Chromatic aberration] or blue chromatic aberration
C Apply NR ) with the [B] slider. Index
Lens aberration correction )| Click the [OK] button.  ——
- The [Lens aberration correction] window closes and the result of
Feanhen ot kn L the corrections is applied to the image in the edit window and the
Distortion OFF image is redisplayed. @ @
e o The result of the settings of the [Lens aberration correction] @
window is also displayed in the tool palette.
EElaElRD LR In the main window, the [g)'.v] mark is displayed on the image to

indicate the lens aberration corrections (p.105).
The [Lens aberration correction] window appears. 59



About Shooting Distance Information Slider

When correcting RAW images taken with the EOS-1Ds Mark Ill, EOS-
1D Mark Ill, EOS 40D, EOS DIGITAL REBEL XSi/450D or EOS
1000D, the slider is set automatically according to the shooting
distance information saved to the image.

However, if EF 50mm /1.4 USM, EF 85mm f/1.2L USM or

EF 28-70mm f/2.8L USM is used, it is set automatically to the right
end at infinity position. You can then minutely adjust the distance by
operating the slider while looking at the screen if the shooting
distance is not infinite.

When correcting RAW images taken with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds, EOS-1D, EOS 5D,
EOS 30D or EOS DIGITAL REBEL XTi/400D DIGITAL, it is set
automatically to the right end at infinity position. You can then
minutely adjust the distance by operating the slider while looking at
the screen if the shooting distance is not infinite.

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by selecting [View] menu » [Tool palette]. If you perform
correction procedures (p.59) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.37).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.56).

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.29).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.27) and/or the color saturation (p.88) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]

correction is made.

@ For a list of the [Lens aberration correction] window functions, refer

to p.113.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [&] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark I EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL o _ )

XSi/450D XTi/400D DIGITAL ~ £O° 10000 2 Additional information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appeatrs. copy stamp window or performing the “Re-Editing an Image”

procedure (p.39).

©® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

® Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.
@ The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the

camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.63) or the copy stamp function (p.65).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

P ¥als] ¥ 172 MG_0030.CR2 (3456 x 2304]

| et ta 1008 Viem 1 parform aemg sparation.

Dust spots are erased in a single operation.
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

Place the dust spot to be erased within the [O] and

_ _ _ Introduction
You can erase dust spots in an image by selecting them one by one.

click.
In the main window, select the image you want to e c
o | ot 0 i ontents at
erase dust spots. e a Glance
Select the [Tools] menu » [Start Stamp tool]. i
The copy stamp window appears. : ) Basic
. . _ ©) Click Operation
When the image has redrawn itself, double-click the
point from where dust is to be erased.
aco < 11w s cas s« : Advanced
oo e 3 o v Operation
Agply Duit Delete Data )
Advapced
i ‘ Imag iting
- ] _‘ R — . . _ and Pfinting
=SS click % The dust spot within the [O] is erased. O g
. . . . Large Numbers
© Click on another part of the image to continue erasing dust spots of Images
in the image.

@ To erase dust in another part of the image, click the button Editing
clicked in step 4 again to cancel dust erasure processing and JPEG/TIFF
perform the operation again from step 3. LEEE

@ When the dust spot cannot be erased, [()] is displayed.

The display changes to 100% view. Click the [OK] butto_n tp return to the main wm_dow. Reference
The display position can be changed by dragging. The [ 2] mark (p.105) is displayed on an image from which dust
_ spots have been erased.
Click the button that matches the dust spot to be ndex
erased.

If the dust spot is dark in color, click the [
the dust spot is light in color, click the [ ] button.
When you move the cursor over the image, the dust erasure
range appears as [Q].

] button, and if

QO
©
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.65).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.39).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.38).

\

~
-

/

> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.63).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <option> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.105) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.81.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.117) is added. The ICC profile
contains information about [Preferences] (p.74) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.

Setting Work Color Space

A different work color space (p.118) from the default settings (p.74) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space setindividually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.74), this
default setting will not be applied and the individually set color space will
remain.

Y

~

2= The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

#| IMG_0001.CR2

Printer :

.{ Printer | Image Text Settings )
i

Media
Ad

Media orientation

) Portrait

@ Landscape

Media size:
297.0 mm x 209.9 mm
Print profile:

CMYK profile:

Select profile
oo X i )

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

“@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.74).
If CMYK simulation has been set, the image is printed in the set
colors (p.74).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.
Select images to be printed in a thumbnail list.
Select the [File] menu » [Contact Sheet Prints].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

Contact Sheet Prints

G Printer | Image = Text Settings j-\

Printer :

Media :
A4

Media orientation:

() Portrait
C Landscape

Media size:

209.9 mm x 297.0 mm

Print profile:

CMYK profile:

Select profile

s
| A EETE— .
Apply )

Print preview

@ To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

@ You can set printer profiles (p.74).

If CMYK simulation has been set, the image is printed in the set
colors (p.74).

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

QO

67



Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Specify the required settings for printing, and then
print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.74) is not applied.

A/

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When the color space is set to SRGB or Adobe RGB (p.65, p.74), this
color space is automatically transmitted from DPP to Easy-PhotoPrint
Pro, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.65, p.74) is set to Adobe RGB and the image
is printed with a high-end Canon inkjet printer, the color reproduction
area widens, and green and blue in particular are reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install the
imagePROGRAF Print Plug-In for Digital Photo Professional on your
computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.70) and CMYK simulation (p.74) are not
applied.

A/

-@> Advantages of printing with the imagePROGRAF Print Plug-In

Printing with faithful colors

When a color space is set (p.65, p.74), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.65, p.74) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the Preferences
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Digital Photo Professional] menu »

[Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

4({ General i | View settings Tool palette | Colorr gement }

Startup folder

) Last displayed folder
() Specified folder

Browse... MacOSX fUsers /canon/Desktop

Save recipe

(¥ Display message when adding file ‘]
) Add to file automatically | |

Viewing and saving RAW images

#) High quality (recommended)
| View images at high speed {moiré reduction off}
) High speed View/save RAW images at high guality
Moiré is reduced and the NR tool palette can be used

JPEG image guality

| Remave block noise and mosquito noise

[_! Display thumbnails at high quality

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

f Cancel ) f 0K 3

General Settings

You can specify the folder that opens when DPP is started up, image

quality of displayed and saved RAW images, etc.

Preferences

—{ General settings | View settings Tool palette Color management

Startup folder

®) Last displayed folder

) Specified folder

Browse | MacOSX fUsers /canon/Desktop

Save recipe
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O High speed View/save RAW images at high quality
Moiré is reduced and the NR tool palette can be used

JPEG image quality

‘ | Removwe block noise and mosquito noise

[ Display thumbnails at high quality

Default value of output resolution

| r 350 dpi(1-60000)

At EOS Utility startup

| Edit image window enabled at EOS Utility startup

r Cancel 3 f
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.56) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.56)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use [100%
view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]

If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied.
As the [View images at high speed (moiré reduction off)] setting is the
same as [High quality] other than for display of the image, the image
undergoes false color reduction processing when it is saved and the
noise reduction function is also available.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window in
the [100% view] or [200% view] enlargement display, and the time it
takes to save a RAW image is less than in [High quality].
You cannot use the noise reduction function (p.56).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

? What is the difference between the [High quality] and [High
speed] displays?

The display image quality of [High quality] and [High speed] is the same
except when the image is displayed in the [100% view] or [200% view]
enlargement display in the edit window or the edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
that is likely to occur when RAW images are converted to JPEG
images and saved (p.38, p.80).
This setting is also effective for JPEG images that have been saved
with a different name.

[Display thumbnails at high quality]
You can have the thumbnails for JPEG images automatically displayed
at high quality. If you checkmark [Display thumbnails at high quality],
all subsequent JPEG image thumbnails imported into DPP will be
displayed at high quality.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.38, p.80).
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View Settings

You can specify settings relating to the display.

Preferences

[ General settings | Miew settings | Tool palette Color management -

Crid pitch
64 Pixels|8-256)
Locking selected image
E Images opened in Edit window remain selected in main window

Magnification in Edit window

®) Fit to window () 50% ) 100% ) 200%

Magnification when the Edit/Edit image window is double-clicked

—

) 50% ® 100% ) 200%
RAW and JPEG
E Display only CR2 images for CR2 and JPEG files of the same name

Sort arder in main window
! Retain sort order

Highlight/shadow warning

Highlight 192 qez-255 [
Shadow 0 (0-64) |

Quick check tool display

® 50% ) 100% {maoiré reduction off)

Cancel

0K

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.19).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.51).
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Tool Palette

You can specify settings for the tool palette.

Preferences

Ceneral settings View settings | Tool palette | Color management

Default settings of RGB Tone curve mode

Tone curve mode Interpolation method
M RGERGEB ) Curve
C Luminance RG B :, Straight

Histogram display
(") Before adjustment
®) After adjustment

Tool palette display in Edit Image Window

(*) Docking display
) Floating display

Modified Picture Style settings

E Retain settings of each Picture Style

Tool palette display mode

|| Same for Main window and Edit window

Default noise reduction settings

RAW luminance noise reduction: {0 G, PO
RAW chrominance noise reduction: {0 @
ST T T ER

TIFF/JPEC luminance noise reduction: {0) e, P
$. T T S

TIFF{JPEG chrominance noise reduction: (0!

( Cancel ) f

Default settings of RGB Tone curve mode
You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-

erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast]
and [Sharpness] settings will be changed or retained, when you change
the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level. For
images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after
making settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

A

=< Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high 1ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP. This eliminates the need to
apply noise reduction to each individual image.

Since you always shoot with the same conditions, it is also useful when
you want to set the same noise reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences

- General settings View settings Tool palette | Color management }

Default settings of Work color space
%) sRGB

) Adobe RGB

) wide Gamut RGB

) Apple RGB

) ColorMatch RGB

CMM settings for print
For display :
%) sRGB
" Monitor profile
ENG/Library/ColorSync/Profiles/Displays/Acer AL1922-1CAB49E4.icc
Printing profile:
" None I+ ]

Rendering intents:

CMYK simulation profile: Rendering intents:

None )

Rendering intents when using Easy-PhotoPrint
" Perceptual

(®) Relative Colorimetric

Cancel \ f 0K %

Default settings of Work color space

You can select from five types of color space (p.118) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.38,
p.80) or printed (p.39, p.42, p.44, p.66 to p.69).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the edit
window (p.106) and the edit image window (p.110).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.65).

Display setting (color setting of the monitor)
Where a profile (p.117) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.

Checkmark the [Monitor profile], click the [Browse] button and in the
dialog box that appears, select a profile for your monitor.

Ay

=)= Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.117) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.44, p.66, p.67) except for printing using a Canon inkjet
printer (p.39, p.42) or linked printing (p.68, p.69).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

-I\@/E Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.39, p.42) or using
linked printing (p.68, p.69), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.118) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.103, p.106,
p.110) in the bottom of the main window, edit window and edit image
window, and colors can be checked.
To temporarily cancel CMYK simulation, press the <space> key.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.118) for printing
using Easy-PhotoPrint (p.42).

The rendering intent is ordinarily set to [Relative Colorimetric].

» When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images —

Introduction
For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
Contents at
here. a Glance
Utilizing Adjustment Contents (Recipe)................... 77 s
Saving Recipes as a File.......ccccoovevveiiieiiiiei e, 78 Operation
Loading and Pasting ReCIPeS..........ccceevvvvviiiieeeeeeennnns /8
Copying a Recipe and Applying to Another Image..... /8 Advanced
. ) Operation
Batch Apply White Balance to Images (Personal White
Balange) PR R YRR e, 79 T
Registering Personal White Balance.......................... /9  |Image Editing
. . and Printing
Applying Personal White Balance .............ccccccceeeee. 79 —
Batch Save as JPEG or TIFF Images (Batch L:I;r;OCSiggrs
PrOCESSING)...uuuiiiiiiiiiiii e e e 80 of Iméges
Batch Transfer Images to Image Editing Software.. 81 E—
Batch Change the File Name of Images.................. 82 J'Tn'ﬁgéL'SFF
Changing the File Name of Images in the Order in the
MaiN WINAOW .......coeeiieiiiiiiiiiiiieieeeee e 82
Reference
Index

QO
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

S #| IMG_0015.CR2

~efRAW RGB | NRLens

|Erighmess adjustment [ = |

|While balance adjustment [ |
. s ot i

Shot settings B Tune.. )

|Picture Style =) |

Standard |¢]I” Browse... )

-10.0 -8.0 -6.0 -4.0 -2.0 O 20 4.0
Contrast: "‘“‘""@—“—“‘
o) T i

| Linear

Color tone: "—-—-"9"“—“"
@ i e
Color saturation: »—-—-—-—-—9—-—-—-—-—
{0 e e

Sharpness: —-9-—-—-—-—-—-——-—-\
i) ! e

RAW image data

- !

I \N
Lvrd

Contents adjusted using the tool
palette can be handled

individually as a recicpe file
(extension “.vrd").

|§| The adjustment contents of JPEG or TIFF images can be saved as
a recipe file (extension “.vrd”) and loaded and applied to another
image in the same way as with RAW images (p.84, p.99).

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens]). For this reason, other editing content such as
trimming or dust-erasure (copy stamp) is not included in the recipe
data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Saving Recipes as a File Copying a Recipe and Applying to Another Image

Select an edited image, and then select the [Edit] You can copy a recipe of an edited image and then apply it to another
menu » [Save recipe in file]. image.

The [Save] dialog box appears. Select the image from which arecipe is to be copied

Select the destination folder, enter a file name, and and then select the [Edit] menu » [Copy recipe to
then click the [Save] button. clipboard].
The recipe is copied.
"2 Check the contents of a recipe file by pasting to an image Select the image to which the recipe is to be applied

o _ , and then select the [Edit] menu P [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
T : selected image].
and check the settings in the tool palette. When only a few settings are o . : i
adjusted, we recommend you use a file name that describes the The recipe is applied to the image.
contents or that you separately record the adjustments as text
information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific . :

shooting environment can be registered as personal white balance. You Applyl ng Personal White Balance

can then perform efficient white balance adjustment by applying this In the main window, select the image to which white
personal white balance to a large number of RAW images shot in the balance is to be applied

same shooting environment.
Click the [Tools] button on the toolbar.

The tool palette appears.

Registering Personal White Balance
Click the personal white balance number button that

Adjust' the vyhlte balance (p.25, 9.26, p.52). is to be applied.
To adjust white balance, select a setting other than [Shot
settings] from the [White balance adjustment] list box (p.25). You ——{RAW | RGB  NR/Lens
will be unable to register the adjustments if you select [Shot \Efiﬂhtﬂm adjustment [ D] ;\
SettlngS]. IIIIIIIIIIIMIIIIIIIIIII {}DD
In the [RAW] tool palette, click the [Register] button. [White balance adjustment B
The [Register personal white balance] dialog box appears. I > | 3 W Register. §
Select the button number to be registered from the Raviig B Tune.. )
list and click the [OK] button.
BN [#| Register personal white balance ‘Pictureswle |£J‘
Register current setting in personal white balance I' standard | :] I'L Browse... \I
Current setting: Click white balance @ i

[ Custom 1 f :D

( Cancel

rh—ll].(] -8.0 -b0 -40 =-20 DO 2.0 4.0

Caontrast:
{u] I 1 I 1 v 1 1 1 1
| Linear
‘{:E;:Jllur tDne 1 1 1 1 v 1 1 1 1
Color saturation: =
v 1 1 1 1

(]} 1 1 1 1

Sharpness:
{]_] ‘l_Glllllllll

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar
(p.103).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings

IMC_0001.CR2 Save folder

IMG_0002.CR2 Mac0SX/Users /canon/Documen s (" Browse

A D00 File format

IMG_0004.CR2

IMG_0005.CR2 Kind of file Exif-JPEG 5

IMG_0D006.CR2 8 —————————ry
Image quality 10

IMG_0007.CR2 .

IMG_0008.CR2 Output setting

IMG_0009.CR2 - -

IMG_0010.CR2 Output resolution 350 dpi W Embed ICC profile

IMG_0011.CR2 Resize setting

IMG_0012.CR2 Resize

IMG_0013.CR2 ” Width Height Unit
IMG_0014.CR2 3456 x 2304

IMG_0015.CR2 ‘/( 3456 pixel |

1 2304 pixel )

File name

: Current file name
String

¥} New file name
String Sequence number

DPP, T 1 -UDDl i B E _ Save sequence number
B DPP_000LJPG, DPP_0D0Z JPG

Image transfer settings
! Open image using software

( Convert RAW images only ) ( Cancel € Execure )

The processing dialog box appears and saving begins.
When all the images are saved, the [Terminate] button appears in
the processing dialog box.

In the processing dialog box, click the [Terminate]
button.

"2 [Save] cannot be performed

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.37, p.98) to edited RAW images.

A/

-@> Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

|§| If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.35,
p.92) or dust-erased image (p.61 to p.65, p.94 to p.98) actually
becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, refer to p.115.
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)

Batch Transfer Images to Image Editing Software _
Introduction
You can transfer multiple images to image editing software. The Select Photoshop CS.
software used here as an example is Adobe Photoshop CS. In the [Open] dialog box, select a Photoshop CS file or an alias
: : : : and click the [Open] button. Contents at
In the main window, select multiple images to be The [Open] dialog box closes and [Image transfer settings] in the a Glance
transferred. [Batch settings] window is set to Photoshop CS.
Click the [Batch process] button on the toolbar Checkmark [Open image using software]. Basic
(p.103). image transfer settings Operation
The [Batch settings] window appears. @DDE" image using software
. . . . Adobe Photoshop CS Browse...
Perform settings required for transferring (e.g. file — Advanced
format). (  cancel ) FEecute) Operation
Click the [Browse] button. Click the [Execute] button. Advanced
e »The processing dialog box appears and batch transfer begins. Image Editing
MG 0001 2 R S When the first image has been transferred, Photoshop CS starts and Printing
mgfgg:-g;i File format. ' up and transferred images are displayed in transferred order.
IMG_0005.CR2 Kind of file Exif-JPEG B Proceflsin g
.07 CR2 ol e Larg bers
IMC_0008.CR2 Output setting : of Im@ges
mgigg?zﬁ;i Output resolution 350 dpi [ Embed ICC profile
M Fis S Editing
i - o B a0
IMG_0015.CR2 (3455pixe|]. {2304 pixel) ST |mages

ViLotk

File Name

) Current file name
String

Reference

(®) New file name

String Sequence number

ppr. ooor [ Save sequence number
Ex. DPP_0001.JPG, DPP_0002.JPG

Image transfer settings |ndeX

g Open image using software

Cancel (’ ~ Execute ')

The [Open] dialog box appears. @ @
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

MacOSX/Users /canon/Pictures /Photo/xxxx_xx_xx

File Name Extension
DPP 2 Shooting Date/Time 3 Sequence number 3 Do not change 3
Basic Settings Format settings
Sort Sequence number
@ Fit to main window UU.Ol ; | Isave sequence number
" File Name

: Shooting Date/Time Shooting Date/Time

! & W+ [ Month Day Year 3
__ Copy & Rename ir MM-DD-YY |
MacOSK/Users /canonDesktop @Insen underbar
Original File Modified File Name
IMG_0001.CR2 DPP_09-13-06_0001.CR2
IMG_0001.JPG DPP_09-13-06_0002.JPG
IMG_0002.CR2 DPP_09-13-06_0003.CR2
IMG_0002.JPG DPP_09-13-06_0004.JPG
IMG_0003.CR2 DPP_09-13-06_0005.CR2
IMG_0003.JPG — DPP_09-13-06_0006.PG
IMG_0004.CR2 DPP_09-12-06_0007.CR2
IMG_0004.JPG DPP_09-12-06_0008.JPG
IMG_0005.CR2 DPP_09-13-06_0009.CR2
IMG_0005.JPG - DPP_09-13-06_0010.JPG
[a -] “ € )

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur.

|§| You cannot start up the rename tool from the [Collection] window
(p.33, p.104).
For a list of the rename window functions, refer to p.116.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window (p.19),
you can change in one operation the names of the files for the images,
in the order they were rearranged.

Change the order of the images in the main window

(p.19).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].
MacOS5x

File Name
DPP j =! Shooting
Basic Settings

Sort

f*) Fit to main window ]
. File Name

() Shooting Date/Time

Specify the required settings (p.116).
To copy an image, checkmark [Copy & Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgstle;ntgeat
Editing JPEG and TIFF Images...........ccceevvvieeeeeeenn. 84 s
About the RGB Tool Palette ........cccceeeeeeeeiiiiiiieineeeenn.. 84 Operation
Automatically Adjusting Brightness and Color (Tone
CUINVE ASSISE) ...cviiiiiiiii e 85 Advanced
Adjusting Brightness and Contrast............cc..ccceuve.... 86 S R
Adjusting Color Tone Using Click White Balance....... 87
Adjusting Hue, Saturation and Sharpness.................. 88 |imagerditing
Tone Curve AdjUSIMENL............cccvriveeeeeieieeeeee e 89 [ and Printing
Adjusting Dynamic Range ...........cccooveeiiiiieiiiiiinnneeenn. 90 Processing
RedUCING NOISE ....cccovviveeeiieieiece e, 91 Laggfe"':ggggrs
Trimming an IMage.......ccooovveeiiiiiieeeeec e 92
Performing Automatic Dust Erasure Processing ..... 94 JPE’§PFF
Compatible CamMeras............cccoeeeeeeeeeeiiieeeeeeecenn, 94 Imeges
Automatic Dust Erasure Processing in the Main
WINAOW ... 95 Reference
Manually Erasing Dust (Repair Function)................ 96
Erasing Unwanted Parts of an Image (Copy Stamp
V1T (10 1) FERT RN 98 Index
Saving Editing Results...........cccccceeiviivviiciie e, 98
Saving Editing Content to an Image................c.......... 98 @ @
Saving as a Separate Image..............ccccevvvvvvveeeeeeennn, 99
Applying Editing Contents to Another Image........... 99 @
PHNTING ..o 99
Re-Editing an Image..........cceiiiiviiiiiiieeeeiieeeeeeeeee 99 83



Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

a8 & # IMG_D015.JPC
" RAW | RGB | NRiLens |
B g =)
Tone curve adjustment |
Rea| r | c | & |
=

255

Tone curve assist

4

l‘

)

)

1] < I \N
. - [vrd |
Brightness: VO Y e P—
ARERRERR T (IRRERUTRT] -
e

Contents adjusted using the tool
palette can be handled
individually as a recicpe file
(extension “.vrd”) (p.77, p.99).

Hue:
Saturation:

Sharpness:

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.98), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.77, p.99).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.89) and
automatic adjustment (p.85), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.117). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most

images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.
— RAW [RGB NR/Lans |
[l ' 1 |7+ [z ——Reverts the tone curve
Tone curve adjustment [ 5] to the original Settings
e ¢ | G [ s ]
255 71 High
Standard
0 \ |
0 255
Eﬂghtﬂess trrrirerrfrerrrrene Dz
cuntraSL trrrrrerrYrerrerrent D?
Hue: L rrerrYrnen el |2! DE
Saturarinn: trrrrreneYrenrnnenn Lgi lDD 3
Sharpness: Q—m,: 0 ?

The tone curve changes as adjusted.

~@ Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

® If you click the [] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.88).
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Introduction
- - - Brightness: Move the slider to the right to make an image
Adjusting Brightness and Contrast g . g ; g
brighter and to the left to make an image darker.
The brightness and contrast of an image can be adjusted. Contrast:  Used to adjust modulation and degree of contrast Contents at
of color. Move the slider to the right to make a Glance
| RAW [RGB | NRiens contrast of an image stronger and to the left to
Tone curve assist O o+ 25 make contrast weaker.
| : [0 [ [io)] B
Tone curve adjustment o | Operation
[EE < | c [ |
255 r I
Advanced
Operation
Advanced
Image Editing
and Printing
= Processing
h ik Large Numbers
) J of Images
: ~—_  Drag the sliders left or
0 255 iaht E g
: o "9 JPEGIFF
Brightness: 0 Tl | es
Contrast: ot Enter numerical values
Hue et LE‘I DE
saturatlun e rereYrerrernne @ ll:”:l z Reference
Sharpness: Q—LEJ 0 ?
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|§| The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[#]] button.

p————— RAW | RGB | NRfLens
‘Tnne curve assist [ [ HE+ HEb|
Tone curve adjustment L-l_-, [
Rlcle]

255

"R F]
|
i

0

Erighmess LYy
Contrast: ’_'_'_Q"_'_"
trrnrrrereYreerrrrene

HIJE ey 'EJ
Saturatlun- et reYrenrnrrene [EJ ll:”:li
Sharpness: e—-@

=

D} D | A | D aD)

=

Click on a point that is to be the standard for white.

ana | Digital Photo Professional - [ MacOSX /Users fcanon/Pictures (Photo/ oo xx_xo: IMG_D010PG |

[II67, 5471; 216, 222,233

The coordinates of the cursor position and the RGB values (8-bit
conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.

@ If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, click the [] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).
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Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall

atmosphere of an image harder or softer.

RAW | RGB | NRilens |
‘Tane curve assist [ il || & I'Ebi|
Tone curve adjustment =] ||
e - [ c ¢ ]
e ;
255
0 -
0 255
EﬂghTHESS: trrrrrrerrYrnenrenn I:l \:F
Contrast: "__'@—_“ ol
trrrrerrYrrerrnrenn L
—
Hue LERARN I8 e |'b?-l| I:l \L
Saturation:
LESLRE IR [RERR RS e
Sharpness: P | s
p Ty |.__b_,J I:l 1:'-

Drag the sliders left or right

e (6] 100 ’:“—} Enter numerical values

)

Introduction
Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
r )
. edder i . Contents at
Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
Sharpness: Move the slider to the right to make an image .
harder, and to the left to make an image softer. Basic
Operation
Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
Eqithg
JP IFF
| es
Reference
Index
? Sharpness is unnatural ]

Adjust sharpness with the window view set to [100% view], [50% view]

or [200% view]. If the view is set to [Fit to window] (full view), the @ @

sharpness will seem unnatural.

ﬁl The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, @
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.117).

Select the tone curve mode and interpolation

method.

RAW | RGB | NRiLens |
|T0ne curve assist il fra's Eb‘
Tone curve adjustment -y
ReB | R |G| | [#]
255
v Curve
Straight o
<control> + click inside
v RGERGEB the graph to display the
Luminance R G B menu
0| )
o 255
ErightnESS: trrerrreerYreenerennn I:l :-,‘-
cnntraSt IIlIIiIIIl\If:'IlliIIIII D :i;-
Hue trrerrrereYreenerennn '\2' D L
X ; —  n e B
Saturation: ETIRIIR (i RNIRLIAT 3 100 LY
= D..—.——. _’-.-
Sharpness \f,llllllllllllllllllll -\2' D '\:"

Make adjustments.
Batch adjusts RGB

Adjusts each channel
— [ raw |[*ReB*S| NRLens |
|Tone curve assist £ &@‘
Tone curve adjustment =
@ [+ 7
755] -_. .'
-3
ZSlS/.
Erightness: m o i
Contrast: m o 1
Saturation: u.m:uD-\r’u.u.u:u. Eﬁi
Sharpness: b —g"-'

Moo ke ll

Click to add a [] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 8.
To delete a [[]], double-click on the [[].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any
adjustments (p.73).
The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.73).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Output
highlight point
numerical
value

Move downwards
Output highlight points

RAW |

RGE | | MR/Lens |

‘Tane curve assist

I

Tone curve adjustment

e |
2

RGB 1R!G!B!

| m—

— 259

Move to the
right
Input shadow
points

Output shadow —

pointnumerical
value

Input shadow —

point numerical
value

— 0

[i]

Brightness:
Cantrast

2557

"~
.
0.
L
n

0

-
L

Hue:
Saturation:

Sharpness:

-l
0 T
e
100 )

n
D.L

Move upwards
Output shadow points

— Reverts the

image to the
original
settings

— Move to the

left
Input highlight
points

— Input highlight

point numerical
value

The horizontal axis shows the input level and the vertical axis shows
the output level.

The setting range of shadow points is 0 to 247 (in 1-stop
increments when entering a value).

The setting range of highlight points is 8 to 255 (in 1-stop
increments when entering a value).

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.73).
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens] tab sheet from the tool palette
in the edit window or edit image window.

Adjust an image.

— RAW | RGB | NRflens }——|

[ |

RAW
Luminamnce naise I
(m 0 10
Chrominance noise ="
[(0)] 0 10
TIFF or JPEG

Drag the sliders right

Luminance noise @—
{U] D 1 LI R N B | LI | 10
Chrominance noise @—
{U] D 1 LI R N B | LI | 10

Apply NR

Tune... ‘

Lens aberration correction

Peripheral illumination

Distortion

Chromatic aberration

Color blur

You can set a noise reduction level from within a range of 0 to 10.

The larger the setting, the larger the noise reduction effect.

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view].
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it may be difficult to
check the noise reduction effect.

? To check the noise reduction effect, enlarge the image and
display it

Because noise reduction effect is difficult to see in the [50% view] and
[Fit to window] displays, use [100% view] or [200% view] to check the
noise reduction.

@ If [Luminance noise] has been set, resolution may be reduced
along with reduction of noise.
If [Chrominance noise] has been set, color bleeding may occur
along with reduction of noise.
You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in Preferences (p.73). This is particularly useful
for applying noise reduction to all the images in a folder at once,
such as batch noise reduction for images with high ISO speeds.
However, where images have a recipe attached, the noise level
recorded in the recipe is applied.
For a list of tool palette functions, refer to p.108.
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Also, when aspect ratio information is attached to an image shot with the
EOS-1Ds Mark Il or EOS-1D Mark Ill, the trimming range based on the
aspect ratio information is displayed.

Select the image to be trimmed.

Select the [Tools] menu » [Start Trimming tool].
The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.

CYals) ¥ 1/1IMC_DO0L JPG (3456  2304]
e Cancel
Select a
!(”w ;'504 - trlmming
Widih  Meight E )
------ g ] I’atIO
: oF
= —— Drag the
Opacity 3 o .
~ ° | trimming
range
TNT S04 1<% (3026, 1E30 ) = (1963 x 1326 1| 150 ] Cancel LSS

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

v Free
1:1
3:2
2:3
4:3
3:4
5:4
4:5
A Size Landscape
A 5Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.
[Custom]: You can trim an image at the specified ratio.

! Click the [OK] button to return to the main window.

=» The trimming range frame is displayed in the trimmed image
(p.105).

=»When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.99).

Display of the trimmed image in each window

» Main window: The frame showing the trimming range is
displayed on the image (p.105).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.99).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark 11l or EOS-1D Mark Ill, the set trimming range based
on the aspect ratio information is displayed. However, since the image
is not actually trimmed, you can change the trimming range or revert
to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.112).

The image is displayed in its trimmed condition.

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.112.

)

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images

E g
JP IFF
| es

Reference

Index

QO

93



Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera Click the [OK] button to return to the main window.
that can attach this data, can be used to automatically erase dust spots. The [3] mark (p.105) is displayed on an image from which dust

spots have been erased.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark I EOS 40D

EOS DIGITAL REBEL EOS DIGITAL REBEL o )

XSi/450D XTi/400D DIGITAL ~ £O° 10000 2 Additional Information

] ) ) ) The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appeatrs. copy stamp window or performing the “Re-Editing an Image”

procedure (p.99).

©® Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

© Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

@ The [Apply Dust Delete Data] button cannot be clicked

P > Even with an image that has Dust Delete Data attached to it in the
; camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing
In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots

- depending on the type of dust. If this occurs, erase those dust spots
Dust spots are erased in a single operation. using the repair function (p.96) or the copy stamp function (p.98).
The image becomes a dust-erased image when saved as a
separate image
The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

- Tali) F 1/ MG 0050 S [ 3456 & 2304
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [O] and
click.
In the main window, select the image you want to e _
erase dust spots. e
Select the [Tools] menu » [Start Stamp tool]. oo e

Pes tege

The copy stamp window appears.

. . . O e Click
When the image has redrawn itself, double-click the oo -

point from where dust is to be erased.

[anAa F 1/ NG00S0 PC [ 1436 x 2304]

Double-
click

=» The dust spot within the [OQ] is erased.
Click on another part of the image to continue erasing dust spots
in the image.

©® To erase dust in another part of the image, click the button
clicked in step 4 again to cancel dust erasure processing and
perform the operation again from step 3.

@ When the dust spot cannot be erased, [(3)] is displayed.

LB 100 1 i st . i3

The display changes to 100% view. Click the [OK] button to return to the main window.

The display position can be changed by dragging. The [&] mark (p.105) is displayed on an image from which dust

. spots have been erased.
Click the button that matches the dust spots to be P

erased.
If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [Q].
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.98).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.99).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.99).

\

~
-
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <F> key. (Press the <B> key to return to
the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <F> key or the <B> key to display the
erased dust spot, and then press the <delete> key to cancel only the
erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <38> + <F11> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.114.
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Saving Editing Results _
Introduction
Erasing Unwanted Parts of an Image (Copy Stamp Function) Saving Editing Content to an Image
You can correct an image by pasting a section copied from another part All the contents (recipe) adjusted with the tool palette (p.84 to p.91) as
of the image to an unwanted part of the image. well as the trimmed range (p.92) and dust-erasure (p.94 to p.98) Contents at
. . . a Glance
information can be saved to a JPEG or TIFF image, or to a separate
Follow steps 1to 3in “Manually Erasing Dust (Repair JPEG or TIFF image.
Function)” (p.96). _ : : Basic
_ _ _ Select the [File] menu » desired item. Operation
Spe_cn‘y the sec_tlon tq be copied. . .
Click on the se_ctlon that is to be the copy source while holding fisen e RN 20 . .
down the <option> key. Open in Edit window (enlarged)... ép\(/a?gtcign
To change the section that is to be the copy source, perform the Lgsedi | .
. . Open window +h I
operation above again. Closad@M low sew
To fix the position of the copy source, checkmark [Fix Copy Advanced
Source position] prae %5 Image Editing
P ' Save As... 0 %8S and Printing
: Add thumbnail to image and save {C#T
Cor_rect the Image. ] ] Convert and save... H#D .
Click or drag on the section you want to correct on the image. [+] Batch process... B Processing
in the window indicates th d [O] indicates th Large Numbers
in the window indicates the copy source an [O] indicates the NP rew folder... N of Images
copy destination. "
The copied image is pasted in the position to which it was :fﬁ]':jemp"' :: E g
dragged. Print with detailed setting... 4+ D JP%IFF
For [Pen type], you can select from [Brush] (the pasted image’s C|°“"=‘Ft Sheet Prints... s ——
borders simulate a brush) and [Pencil] (the pasted image’s NIEEenTng =
borders are Sharp)_ Add to collection #0
Remove from collection {+3G Reference
Click the [OK] button to return to the main window. Delete %<
The [8,] mark (p.105) is displayed on a corrected image. (53 B
Your adjustments are saved to the image. Index
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.84 to p.91)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.38)

Batch save as JPEG or TIFF images (batch processing) (p.80)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.37)

Utilizing adjustment contents (recipe) (p.77)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.39)

Printing with shooting information (p.66)

Printing a thumbnail list (contact sheet printing) (p.67)

Printing RAW images on a high-end Canon printer (p.68)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.84 to p.91), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.92) or dust-erased image (p.94 to
p.98) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.98) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left #L
Rotate Right 3R
Add check markl HF1
Add check markz2 HF2
Add check mark3 HF3
Clear check mark HF4
v ST

Waork color space >
Tone curve assist - Standard

Tone curve assist - High

Revert to last saved settings “_3Z
Revert to shot settings ~37

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting.........ccvceiviiiiiiiii e 101
Deleting the Software (Uninstalling) ...................... 102
List of Main Window (Folder Window) Functions .. 103
List of Main Window (Collection Window) Functions... 104
Image Frame Information in the Main Window and Edit

Image WIndoW...........ccoooeviiiiiiiieeceee e, 105
List of Edit Window Functions ...............ccccceeeeeee, 106
List of Tool Palette Functions ...............cccceeeeennnn.e. 107
List of Quick Check Window Functions................. 109
List of Edit Image Window Functions .................... 110
List of Convert/Save One Image Window Functions 111
List of Trimming Window Functions....................... 112
List of Lens Aberration Correction Window Functions 113
List of Copy Stamp Window Functions.................. 114
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLIONS........coccoviieiiiineeeeeeeeei, 115
List of Rename Window Functions........................ 116
GlOSSAIY ..evviiieiieeie e 117
INAEX ..o 119
About This Instruction Manual .............................. 123
Trademark Acknowledgments.............cccoeeeeeeenn. 123
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.61 to p.65, p.94 to p.98) is displayed in
a window other than the copy stamp window, it is displayed as it was
before dust erasure was performed. Check dust-erased images in the
copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.107).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.23, p.103, p.109, p.110),
trimming (p.35, p.92), dust erasure (copy stamp) (p.61 to p.65, p.94 to
p.98) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.107).

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.65,
p.74) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sSRGB color space. In this case, set the RAW image color space
to SRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.74) and a profile for a printer is
set up correctly (p.74), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.39, p.42) or linked printing (p.68, p.69) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.43).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.45).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with the EOS 10D and
EOS DIGITAL REBEL/300D DIGITAL may not display image
information (p.10, p.21).

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

8006 ~ Applications -
| « |[88= m|| %~ | Q
ﬁ! Network ‘ N @ ng’;
| = | % e
| i} Mac0S_10.4 J ‘ i =
| =n Mail omniGraffle OmniQutliner
| 10 Data_01
@ Q @
Preview QuickTime Player Safari
s @‘
5 Docu N .
gt} Sherlock Sticki System Preferences
| ovie
usic 57
| y 4 ¢ ¢
| Picture!
= TextEdit Utilities Canon Utilities
® == 37 items, 217.24 GB available 7

Drag the folder for the software to be uninstalled to
the Trash.

Select [Finder] menu on the desktop » [Empty Trash].

The software is deleted.
When uninstallation ends, restart your computer.

® You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.

)
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List of Main Window (Folder Window) Functions .10 e duetion
Shows/hides the tool palette (p.107) Check marks (p.18)
Shows/hides the folder area Selects all images Removes check marks (p.18)
Switches to the edit image Cancels selection of allimages  Folder path Image rotation (90 degree units) CErEE
window (p.110) | | a Glance
@} Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help ‘
1 Digital Photo Professional - [ MacOSX/Users/canon/Pictures/Photo/xxxx_xx_xx ]
Toolbar* .

) o5 Batch conversion/ Basic
[Collection] tab sheet saving (p.80, p.81) e R
[Folder] tab sheet*® e

Ll\ i:rzl::r(ai?: \slems
Moo Advanced
¥ (@ Desktop Operation
> ‘,_‘:L-Isnl-;:slms - L S I Y
g : :::i: """ @ ~ " IMGOD0ACRZ |
‘): Music = = Advanced
v 3 pures Image Editing
”"1‘,’?:"?(:’“_“_“ and Printing
» (& Public
» (3 shared Processing
o Large Numbers
Folder area*z 1NG_D008.CRZ IMC_0009.CR2 of |mages
Editing
JPEG/TIFF
Images
® : @ ® B
IMG.0012.CR2 ra I IMG_0014.CR2 _ IMG_0015.CR2 .
Reference
) Index
Information display*3 — (1841, B71): 196, 198, 202 High quality Re‘:ipe dara: Yes quberofimages. 15 Number of selected images: 1 CM\‘Ki//j— CMYK SImUlatlon
_ | \ , display (p.74)
Display mode** Number of selected images
Recipe attachment status (p.77) Number of displayed images @ @
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.70) of the @
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed.
thumbnail list on the right. *> You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette. 103
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List of Main Window (Collection Window) Functions =33 _
Introduction
Shows/hides the tool palette Check marks
Selects all images Removes check marks
Switches to the edit image Cancels selection of all images ‘ Image rotation (90 degree units) CErEE
window | a Glance
@} Digital Photo Prpfessiongl File [dit View Bookmark Adjustment Tools Window Help EE o |Wed 3:13PM Q
ene Digital Photo Professional - [ Collection]
Toolbar ; > - : - ) F - _
Collection] tab sheet*l ) ‘ ) (B9 ‘ ) ‘ 7k Batch conversion/ Basic
[Collection] tab shee ﬁ T saving Operation
[Fo|der] tab sheet 4 Folder __ Collection(14) .
e 4 Advanced
~ Operation
P .\-. == _.-d
© MGLODOLCRZ T MG_o00ZCRZ - ~ IMG_0004CRZ : CRZ @ |MG_0006.CR2 @ IMG_0007.CR2
- - % 3 I 1. - I | I | B Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
Editing
JPEG/TIFF
Images
Reference
Index
|nf0rmati0n dISpIay L (1841, 871): 196, 198, 202 High quality Recipe data: Yes Number of images: 7 Number of selected images: 1 o CMYK Simulation
display

!
Display mode Number of selected images
Recipe attachment status Number of displayed images @ @

*1 The total number of images added to the [Collection] window is @
displayed in the () in the [Collection] tab sheet. Accordingly, when an
image is added that is displayed as a single image (p.20), twice the
total number of displayed images is displayed.
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Image Frame Information in the Main Window and Edit Image Window .10.p.31)

Information displayed when [Large thumbnail] (p.10) is selected

806

Folder

Digital Photo Professional - [ MacOSX /Users/canon

Check mark

¥ =) MacOsX

(p.17, p.18)

Brightness adjustment —|
value*! (p.24)

b |4 Applications
[F Temporary Items
¥ |k Users
¥ 8 canon
- @8 Desktop
[F Travel
- | Documents
b | & Library
| = Movies

¥ |zl Pictures
v [F photo
[ waooe_xx_xx
b | & Public
B | Sites
P [ shared

Copy stamp mark
(p.61to p.65, p.94 to0
p.98)

Lens aberration
correction mark (p.59)

Trimming range*®
(p.35, p.92)

Aperture*3

IMG_0002.CR2

‘

i [l

White balance icon*1 (p.25)

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.20).
[RAW] is displayed in RAW images. (In [Small thumbnail] (p.10), [R] is

displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

’ RAW adjustment mark*1 *4
RGB adjustment mark*® *>
Unsaved editing content mark

File name

Image type*?
Shutter speed*3

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to an image shot with the
EOS-1Ds Mark 11l or EOS-1D Mark I, the image is displayed as a
trimmed image.
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List of Edit Window Functions .11, p.23 o duction

Path and file name of image Tool palette*! (p.107, p.108)
(iala) [#| Digital Photo Professional - [ MacOSX /Users /canon /Pictures,/Photo/xxxx_xx_xx/IMG_0001.CR2 | f[ooo [# IMG_0001.CR2 Contents at
| RaW | RGB  NRiLens a Glance
| Brightness adjustment 'E]|
U A T 0.00
|'M1il! balance adjustment [3]| BaSIC
1215 Cregmer) B
[ Shot settings Hr}( Tune... )
| Picture Style Advan Ced
p Operation
| Standard
Advanced

Image Editing
and Printing

100 -3.0 -6.0 -4.0 -20 0

Contrast:

e e Processing

i . Large Numbers

o S of Images

Color ion: -

()] [l S

Sharpness: .

i Siisrrnaw Editing
JPEGI/TIFF

Images

Reference

(1576, 1021) : 157, 165, 189 High guality RAW / Adobe RGB CMYK b = Index
Information display*? Display mode** CMYK simulation display (p.74)
Image color space*3 and work color space (p.65, p.74) @ @
*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW]. @
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.70) of the
bit conversion). [Preferences] window is displayed.
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List of Tool Palette Functions
RAW Tool Palette (p.23)

Y ¥ IMG_0001.CR2
———| RaW | RGB  NRiens
N
|Erighrness adjustment - |
‘IIIIIIIIIIImIIIIIIIIIII E-DD J
White balance adjustment §=] |
1 [ 2 [ 3 | Register: )

Shot settings

i:]( Tune..

.

| Picture Style

=]

Standard

| :] [:_ Browse... J

| “T0.0 8.0 60 40 -20

0 2.0

die )
Contrast:
{UJ 1 1 1 1 V 1 1 1 1
"1 Linear
i
Color tone:
{U‘; arone 1 1 (? 1 1
Color saturation:
{UJ 1 1 V 1 1
N
Sharpness: e
{]_J p 1 VI 1 1 1 1 1 1 1 1

—— Brightness adjustment (p.24)

— White balance adjustment

(p.25, p.26, p.52)

— Picture Style settings (p.24, p.53)

- Dynamic range adjustment (p.53)

Contrast adjustment (p.27)
Linear setting (p.27)

Color tone and color saturation
adjustment (p.27)

Sharpness adjustment (p.29)

Enlargement display position*!

RGB Tool Palette (p.55)

& & &

¥ IMG_0001.CR2

RAW |

RGB

| NRiLens

|Tr.me curve assist

Tone curve adjustment

-

[ Rcs ]R|G|B|

&

255

0
. N
E"ghmESS: (AR NE NI Iml 110 D A
cuntraﬂ- (ERANREE LRy ARSER N D Al
) o
Hue; (R AR RN Iml AN EJ D s
o g——
saturatlﬂn: i Iml [RERERE lEJ 100 W
Sharpness: e—- 4 0 (<)
frrrrrrnnrrrennennd Il—J =

Automatic adjustment

(@] @+ E0)— (tone curve assist) (.30, p.85)

Click white balance (p.87)

- Tone curve adjustment

(p.54, p.89)

- Dynamic range adjustment (p.90)

Brightness and contrast
adjustment (p.86)

Hue and Saturation adjustment
(p-88)

Sharpness adjustment (p.88)

Enlargement display position*!

*1 If an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears when
[Docking display] (p.73) has been set and the edit image window (p.110)
has been enlarged.

)
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NR/Lens Tool Palette (p.56)
(When a RAW image is selected)

& & & 4% IMG_1001.CR2
| RAW RGB | NRflens } |
[ |
RAW
3 . . .
[Lummnce naise e Luminance noise reduction for
{01 D LI IR R I ER N B N B | lUJ RAW images (p.56)
S
[{co';m“‘i"&“““"‘“ i ey | Chrominance noise reduction for
J RAW images (p.56)
TIFF or JPEG
Luminance naise - -
(0 0 10
Chrominance noise —r e
0] 0 10
. Apply Nk ——— Apply NR button (p.56)
f Lens aberraticn correction |
Peripheral illumination OFF
Distortion OFF —— Lens aberration correction (p.59)
Chromatic aberration OFF
Caolor blur OFF

Enlargement display position*1

*1 If an image is displayed enlarged, the enlargement
display position can be moved by dragging. The enlargement display
position appears when [Docking display] (p.73) has been set and the
edit image window (p.110) has been enlarged.

NR/Lens Tool Palette (p.91)

(When a JPEG or TIFF image is selected)

EED ¥ IMG_1001JPG
RAW | RGB | NRflens | —
= |
RAW
Luminance naise —r -
{0) 0 10
Chrominance noise — .
{0) 0 10
TIFF or JPEG
N
Luminance noise
[{UJ 06..........10
\
Chrominance noise —r
|(UJ ] RN |« 1 0 VR0
J

-

| Lens aberration correction

Jiune... |

Peripheral illumination
Distortion
’ Chromatic aberration

| Caolor blur

Luminance noise reduction for
JPEG and TIFF images (p.91)

Chrominance noise reduction for
JPEG and TIFF images (p.91)

PSR L Apply NR button (p.91)

Enlargement display position*1

)
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List of Quick Check Window Functions .16,p.17)

Check mark display

50% view/100% view (moiré reduction off)/full view*!
File name of image Check marks (p.17)

¥ 2/15 IMG_0002.CR2 [3456 x 2304] Displaystheimage

in full screen*2
Check mark | cear —+— Removes check

(O3 2z JI s J| marks(p.17)
(Previous ) ( Mext )

\
l 50% wview J [ Full screen'.]_

Switches between
displayed images

N Info... j—— Displays the image

— information window
C Rotate }EE—) C Rotate right ) (p22)

25 Image rotation
(90 degree units)

o)

e

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Digital Photo Professional] menu and using
[Quick check tool display] in the [View settings] tab sheet. You can
also move the display position in the enlarged display by dragging the
image.

*2 To return to the normal screen, press the <esc> key.
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List of Edit Image Window Functions ©.31p.33

Shows/hides grid*4
Enlargement ratio of displayed image
Switches between displayed images

Shows/hides tool palette
Shows/hides thumbnail display area
Switches to main window

Image path and file name
Image rotation (90 degree units)
Batch conversion/saving

.103 | .80, p.81
(p ) " @ Digital Photo Prjpfessional File Edit View Affjustment Tools Window | Help = 4) |[Ved 3:18PM [3) (p ,p )
\ E Digital Photo Professional - [ MacOSX/J:|ers/canon/Pictures/Photo/xxxx_xx_xx/IMG_0003.CR2 ]
Toolbar
Shot settings B Tune.. )
‘Pi(lurg Style LEJ‘
[ Standard %) ( Browse... )
‘| 4+— Tool palette
o LU | (p.107)
-10.0 -80 -6.0 -40 -2.0 20 40
Thumbnail display area*3 e ey
7 Linear
{Cudzlur T
Sharpness: Ff————
iy
— CMYK
- simulation
display
Information diSplay*Z {(1258, 1109) . 136, 145, 178 High quality RAW / Adabe RGB CMYK 7] (p74)

Display mode*>  Image color space*! and work

color space (p.65, p.74)
*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.72).

*> The item selected in [Viewing and saving RAW images] (p.70) of the
[Preferences] window is displayed.

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.
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List of Convert/Save One Image Window Functions s e
Convert and save
| File name Cg’gg};‘g eat
Save As: DPP_001 | [+]
Types of image :
. ; Where: [ Photo 44 Save destination Basic
Type. of image Extension Operation
Exif-JPEG JPG File format_
Exif-TIFF 8bit TIF : =— <
TIEE 16bit TIF Kind of file Exif-JPEG 3 gdvan(_;ed
ppp— , , : = JPEG compression rate*3 peration
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Image guality i — — 1l P
TIFF 16bit+Exif-JPE .TIF/.JP ;
6bit+Exif-JPEG 1.JPG i " i —3 . Embeds of ICC profiles*2 (p.117) Advanced
: : , : Image Editing
350 =~
Resolution*L Output resolution i dpi || Embed ICC profile ol 1
( Resize setting 48 . N _— ) N
| Resize Processing
. . Width Height Unit LT Yl 575
Size changing*4 . _ —= of Images
3504 & 2336 pixal =
{ 3504 pixel) { 2336 pixel ) B U _ r
Y A& o Editing
i f Lock &spect rFatic ) JPEG/TIFF
Images
{ Cancel :,I { Save )7_ Save

Reference

Index
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher -
*2 Color space (p.65, p.74) information that is set in an image is attached the image quality becomes.
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @ @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65,
p.74), the ICC profiles are embedded automatically. @
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List of Trimming Window Functions .35 p.92) oduetion

Cancels all the trimming (aspect ratio) information

GIalE £ 1/1 IMG_0001.CR2 [3456 x 2304] —= | Full screen display/returns to normal screen
pRONIEOw, Contents at
(G ) ( FResst | Reverts to the condition when the image was shot 2 Elemee
pepec o . | Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1 Basic

s e J _ _ Operation
Upper left coordinates of trimmed range (you

X 7. ) -

e £y so 8) can also enter numerical values)

e e | Size of trimmed range (you can also enter Yo B
52 — numerical values) Operation

—— Copies the trimmed range and applies (pastes)

(( Copy ) | Past@ 1.1
it to another image*2

el _ o Advanced
— show borders Applies the copied trimming range to all other Image Editing
Opacity = images*?2 and Printing
""" L evelof opacity outside a trimmed range ;
Lu ous- ! | Next y LPrOCSSSIQg
. . . arge Numbers
L Switches between displayed images*? 0% Images
&
&7 Editing
JPEG/TIFF
Images
—_—— = Reference
{1037 ,504 ) -> (3026, 1830) = ( 1989 x 1326 ) [ 1.50 ] %

Trimming range Displays borders around a trimmed range Index
*1 If [Free] has been selected in the [Aspect ratio] list box, you can also @ @
drag the borders of the trimmed range to change its range.
*2_ Qperates when you have selected multiple images and the trimming @

window is displayed.
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List of Lens Aberration Correction Window Functions ¢ 59

er""\r“"\

Lens aberration correction - [IMG_1001.CR2]

|

Shooting distance information

— Enlargement display section*!

Reverts to the condition when the
image was shot

Enlargement display position
(Navigator display)

*1 The area you clicked on the image (Enlargement display position) is
displayed at 200%.

- Shooting distance information
B2 slider (p.60)
" Peripheral illumination ) i i i i .
= f— Peripheral illumination correction
— SR 100 | J
| Distortion ) i . .
-« -m B Distortion correction
J
_| Chromatic aberration ) . . .
— = Chromatic aberration correction
Uy )
R ~ )} Corrects blue chromatic aberration
T Color blur Color blur correction
Shows/hides position of
¥ Mavigator enlargement display section
() Grid
[ Cancel ) ( oK :l
Corrects red chromatic Grid display

aberration

)
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List of Copy Stamp Window Functions .61t p.65 p.94t0p.98)

[¥ 1/2 IMC_0050.CR2 [3456 x 2304]

[ 100% view 1 [ Full sizé view }—
[ Apply Dust Delete Data :3—

(Lighn (Dark) h

O H @

__Fix Copy Source position

Pen type
%) Brush

) Pencil

,
>

o0

Set to 100% View to perform stamp operation.

* Operates when you have selected multiple images and the copy
stamp window is displayed.

— Full screen display/returns to normal screen
— Applies Dust Delete Data (p.61, p.94)
— Types of dust to be erased (p.63, p.96)

. Specifies the copy source (p.65, p.98)

— Fixes the copy source position (p.65, p.98)

— Types of stamps (p.65, p.98)

Sets the size of the dust erasure range (p.63,
— p.96) or copy range (p.65, p.98) in arange of 5
to 100 (in one pixel units) (you can also enter a
numerical value)

Restores/redoes the image

Copies the dust erasure range or copy range and
applies (pastes) it to another image

Switches between displayed images*

)
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List of Convert/Save Multiple Images Window (Batch Processing) Functions s

Batch settings
Save folder
T [ IO }_ Save destination
IMG_0002.CR2 MacOSX /Users /canon/Documents Browse... ]
NS DONSneRe File format
IMG_0004.CR2 5 e ' e — ;
IMG_0005.CR2 4(Kind of file Exif-JPEC | :D
IMG_0006.CR2 LEbe = I i 3
| | M 0007 CR2 mame gty TEEmeEE————— JPEG compression rate*
File names of images to be ———mc_ooos.cr2 Output setting e : Resolution*1
h sav IMG_0009.CR2 _
batch saved IMG_0010.CR2 Output resolution 350 dpi @ Embed ICC profile ——————+— Embeds ICC pr0f||es*2 (pll?)
IMG_0011.CR2 [ Resizesetting =~ = P ren
IMG_0012.CR2 " Resize
IMG_0013.CR2 Width Height Unit . .
IMG_0014.CR2 3456 x 2304 ﬁu__: S|Ze Changlng*4
IMG_0015.CR2 { 3456 pixel ) {2304 pixel)
“f!'.--:. 1ECT ralid J)
Types of image [ File name g9 2
. Current file name
Type of image Extension String
Exif-JPEG JPG _
Exif-TIFF 8bit TIF N T File name
TIFF 16bit TIF | String Sequence number
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG SEE il L /38 seaiione e s
. . Bt DPP_DOOL.IPC, DPP_OCO2.IPG
TIFF 16bit+Exif-JPEG | .TIF/.JPG \ J
(_Image transfer settings SRR A
[pPhenggiite using sofiware : : Batch transfer to other image
v B editing software (p.81)
’ Convert RAW images only ‘ / Cancel ‘ ( Execute }
Images to be converted are limited to RAW images*>  Save
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.65, p.74) information that is set in an image is attached the image quality becomes.
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size.
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.65, *5 Appears when you click the [Batch process] button (p.103, p.110)
p.74), the ICC profiles are embedded automatically. without an image selected in the main window or the edit image

window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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List of Rename Window Functions rs2)

Order in which images are sorted

MacOSX /Users/canon/Pictures/Photo/ xxxx_xx_XX

( File Name

\.

DPP 3 Shooting Date/Time B Sequence number

Extension )

B Do not change 3
J

E: Basic Settings

)

r .
Format settings

N\

Sort

Check mark to apply the same —
name to RAW images and JPEG
images recorded simultaneously

Check mark to copy the images

£%) Fit to main window
" File Name
€ :, Shooting Date/Time

e name for RA

Sequence number

Shooting Date/Time
Month Day Year

( " Copy & Rename

) MM-DD-YY

MacOS¥ /Users /canon /Desktop

Click the [Browse] button and set
the save destination

@Inser‘l underbar

\

0001 _ Save sequence number

)
4

Original File Modified File Name

IMG_0001.CR2 DPP_09-13-06_0001.CR2 |
IMG_0001.JPG H DPP_09-13-06_0002.JPG H
IMG_0002.CR2 | DPP_09-13-06_0003.CR2 !
IMG_0002.JPG |DPP_09-13-06_0004.JPG |
IMG_0003.CR2 DPP_09-13-06_0005.CR2

IMG_0003.JPG — DPP_09-13-06_0006.JPG

IMG_0004.CR2 DPP_09-12-06_0007.CR2

IMG_0004.JPG DPP_09-12-06_0008.JPG

IMG_0005.CR2 DPP_09-13-06_0009.CR2

IMG_0005.JPG - |DPP_09-13-06_0010.PG =
P - — <= g —————— = H i

( Cancel )(-Execm:e)

Sets the new file name

Sets the format of information

in the file name
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
you view on a monitor and the color of an image you have printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

|ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

ColorMatch RGB :

Standard color space for Windows. Widely used for

the standard color space of monitors, digital

cameras, and scanners.

A wider color space than sSRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

A slightly wider color space than sRGB. Mainly

used for printing for business purposes.
Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

y

Color range that can be
seen by the human eye

Gamma White point

value (color temp.)

sRGB 2.2 6500K(D65)

——————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.
Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A

AdJUSE JPEG IMAQGES ...ttt eeeeeeeeeeeeeneeneees 84

AdJUSt RAW IMAQGES....uuuuiiuuiiuuiiiniiiniinniriiiusrenasssrresrrransrrrnerrrrree—————. 23

AdJUSE TIFF IMAQJES. .. . uueiiiiiiiiiiiiiiiiiiieitieeiieeeieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 84

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve ASSISt).......ccoeeeiieiieeeiieceenns 85
BIGNINESS ...ttt 86
Click Whit€ BalanCe .......ccvuiiiiiiiieee et 87
(O70] 011 7= 151 86
DYNaMIC RANQE .....viiiiiiiiieeieeieeeeeeeeet e, 90
i 10 L= 88
RGB TOOI PAIELE ... 84, 107
=100 [ = 11T ] o [ 88
I = 0] LTSS PPP 88
Tone Curve AdjUSIMENT......cccoieii i 89

Adjusting (RAW image)
APPlY AdJUSIMENTS ... 78
Automatic Adjustment (Tone Curve ASSISt).......ccceeeeiieieeciieiiiennes 30
BIIGNINESS .eviiieiiiiiiieieeee et 24
Click White BalanCe .........cooeviviiiiiii et 26
COolOr SATUIALION ..cevniie e e et e ean s 27
(7o) (o gl =T 0 0] 0 1=T =1 (0[PP 52
(©F0] [0 gl 1] £ [T 27
(OF0] (o] TAY ] g T<T=] 52
LO70] 011 7= 1) N SN 27
(070 o)A AV 18111 41T o £ 78
DyNnamiC RANQEe........cuuuiiiii e 53
[ L= gl 1 (<o A 28
1Y/ o1 4] (] 0 1 [ 28
Personal White BalanCe ...........oooeeiiieiiiiiiiiieeeeeeee e 79
PICIUIE SEYIE .ot 24
Picture Style File ......uvveeiiii e 53
RAW TOOI PaAlBte ... 107
SaVE AGJUSTMENLES ....oeiiiiiieiiiiiieeee et 78
SNAIPNESS ..o 29
Tone Curve AdjUSIMENT........ooiiiiiiiiiiee et 54
Toning EffeCt ..o 28
Lo Y01l 2= 11=] 1 (= 12,107, 108
WHItE BaAlAnCe ...ceeieeeiiee e 25

Adjustment Contents (RECIPE)........uuvrrrreerrrerrirreeerreerrereeeereerneeeen 77,117
AdODE RGB ... 118
F Y o] o] L= L1 = TSP 118
AITaNgE IMAGES ..ottt e ettt aeaaeeees 18, 19
Automatic Adjustment (Tone Curve ASSISt) ......cccvvvevvieiiieiiieiinnenn., 30, 85
Automatic Dust Erasure Processing.......ccccccveeeveeveeeveeenennn. 61, 62, 94, 95
B
Batch Apply White Balance to Images (Personal White Balance)....... 79
Batch Change the File Name of Images.........cccccceevviiiiiiiiiiieeeeeeiie 82
Batch Convert/Save Images (Batch Process) .......cccccccceeeveeeeevvveennnnnnn, 80
Batch Process (Batch Save JPEG and TIFF Images)................. 80, 115
Batch Process of Multiple Images
Change File NamMEe ........coooiiiiiiiiii e 82
Convert/Save (BatCh ProCeSS)..........uuvvvvvvrvevrirervinneerrrenrnennns. 80, 115
Personal White BalanCe...........cccccovviiiiiiiiiiiiiiieeee e 79
RECIPE DAtA ....coevviiiiiiiiiiiiiiiieii e 77
T ANS O .. e 81
Batch Settings WIiNAOW. .........ccooiiiiiieee 80, 81, 115
Batch Transfer IMages .........ccccceuuiiiiiiiiiiiiiiiiiiiiieieeieveeev e eeeeeeeeees 81
Batch Transfer Images to Image Editing Software.............cccccoeeunnnen. 81
Before/After Comparison Display ...........ccceiiiiiiiiiiiiiiii e, 49
DIt NUMDET ... . e e s 117
BOOKMArK ... a7
BIIgNINESS ... 24, 86
C
Change File Name..........ooooiiiiiii s 82
Changing the File Name of Images in the Order in the Main Window. 82
Check Mark ..., 17,18, 105, 109
Chromatic Aberration COrreCtion ..........ccoeeeeiiesieiieecceceeees 59
Chrominance Noise Reduction (JPEG, TIFF Images).......ccccccceeeeennnn. 91
Chrominance Noise Reduction (RAW IMages) .........ccccuvvveveeeiiiiiiinnnn. 56
Click White BalancCe...........ccoooiiiiiiii, 26, 87
CMYK SIMUIALION ©.civniiii et a e 74,75, 118
Collection WINAOW .........uuuiiiieeeiiiiiiiiiieee e e e eeeeeee s 6, 33, 104
(670 (o] =] [V g 011 =Tox i o] o 59
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(0] o] 061 o T- T SRRSO PPPPPPPR 118
Color Management (Color Matching)..........ooooeeeeeeiiiiiiieeeeceee 117
Color Setting of the Monitor (Profiles) .........ccccvveviieiiierieeiiieiiieee, 74
Color Setting of the Printer (Profiles).......ccccceevvveeiiiiiiiiiennnn. 74,75
COlOr SPACE.....co ittt 118
ICC Profiles ..o 117
Color Management (Preferences)..........cveeeviiiiiiiieeeeeesiiiiieeeeee e 74
Color SAtUration ..........covieiiiee e 27
Color Setting of the Monitor (Profiles)...........oooocviiiiiiiiiiiiiieeeeee 74
Color Setting of the Printer (Profiles) .........ccccvvvviiieiiii e, 74,75
COlON SPACE ... . 118
AdODE RGB ..., 118
APPIE RGB ... 118
Color Space Setting for Each Image ..............eeueeevieiiiiiiiiiieeieennenn. 65
(7] (o 141V =1 (od I 2 L €1 = S 118
Default Setting of Color Space .......cccccvvvvvvvvviiiiie 74
SRGB ... s 118
Wide Gamut RGB.......oooi 118
Color Space Setting for Each Image...........cccoooeeiiiie, 65
Color TEMPEIAIUIE......cceeeeieeeeeeeeeee e, 52
COlOr TONE ., 27
COlOr WNEEI ... 52
ColorMatCh RGB........cooiiiiiiiee 118
Compatible Cameras with the Lens Aberration Correction Function.. 57
Compatible Lenses with the Lens Aberration Correction Function..... 58
Contact Sheet Printing (Printing a Thumbnail List)............................ 67
CONTFAST .t 27, 86
Convert to JPEG or TIFF Image and Save................... 38, 80, 111, 115
Convert/save One Image Window ........cccoeevvveviviiinineeeeeeeeeeennnnn, 38, 111
Copy Stamp (Image COrrection) ...........eeeeeeeriiiiiriieeeeee e 65, 98
Copy Stamp WINAOW .......coevieeiiiiieiiiiiinc e, 61, 63, 94, 96, 114
Copying and Pasting (Applying) RECIPES........ccccuvviiiiieiiiiiiiiiieeeeeeee 78
Correct Images (Copy Stamp Function) .........ccccceeeeieeieeeeeeeeevnnnnnn, 65, 98
Creating @ FOIUET ... 45
D
Default Noise Reduction Settings ...........ccuvvvriieeeiiiiiiiiieeeee e 73

Default Setting of COIOr SPACE .........uuvvuiiiiiiiiiiiiiiiiiiiiiiieee e 74
Delete IMAGES ....ccoiiiiiiieiee et 45
Deleting
Delete IMagesS.......oovvviiiiiiiieee e 45
Delete the Software ..., 102
Deleting DPP (Uninstalling) ........ccoooeeiiiiieiiecneieees 102
Detailed Setting Printing (Printing with Shooting Information)............. 66
Display
Before/After Comparison Display.........cccccceviiiiiiiiiiiieeiiieeen 49
Enlarged Display (Edit WIiNdow) ... 11, 106
Enlarged Display (Quick Check Window) ............ccccvveeeennnns 16, 109
Shooting Information Display ...........cceevvvveevieiiiiiiiiiiieiiieieeeee, 10, 21
Single IMage DISPIaY .........uveerreriiiiiieiiieiieeeeeeeeeeeeeee e eeeeeeeees 20
Synchronize Edit WINAOW ............cevieivieiiiiiieiiieeieeeeeeeeeeeeeee e 50
Thumbnail Display (Main Window)..........cccccceeeioiiiiiinniiinennnes 10, 103
Thumbnail Display and Enlarged Display
(Edit Image WiNAOW) ..........cccuiiieiieeeiiiiiiiie e 31, 110
DiStortion COMECHION .....uuveieiiiiiiiiiiiiieee e 59
Downloading an Image to Your COMPULET .........ccooviiiiimiieeeeeiiiiiieeeeee 7
Downloading Images from a Camera .............ccceeeeeeeiiiieeeeeeee, 7
Downloading Images from a Card Reader..........ccccccoovivvivieeeeeennnns 9
Downloading IMAgES .........uuuuuiuiiiiiiiiiiiiiiiiiiiuiiarrrreerarrerrrrrrrrrrrr e 7
Downloading Images from a Camera...........c.eeeeeeeeiiiiiiiiiiieeee e 7
Downloading Images from a Card Reader ...........ccccccceeeieieevivveeeiinnennn. 9
DUSEt DEIEte Data ... .ccvveieiieieeeee et 61, 62, 94, 95
Dust Erasure Processing
Automatic Dust Erasure ProCcessing ........ccceeeeeeeresennnnnnnnnnnnnns 61, 94
Image Correction (Copy Stamp Function) .........ccccccevvviivinnnen. 65, 98
Manual Dust Erasure (Repair Function) .........ccccoeeeeevvvevvnnnnnnn. 63, 96
DyNamiC RANQE ......coiiiiiiieeeeiis et e e e eanee 53, 90
E
Edit Image WINAOW...........uuuuiiiiiiiiiiiiiniiieiiieereeseeeeeeeeeeereeeeeeeeeeeeees 31, 110
o [ AR ATAT o [0 . AT 11, 106
Editing......coooiiii e - Adjusting
Enlarged Display (Edit WINAOW) ............euueiiiiiiiiiiiiiiiieieeeeeeeeeeeeee 11, 106
Enlarged Display (Quick Check WINdOW).............uuvvvivivvviniiinineneennne. 109
L@ S 111 S SEUR ST 7
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F
False Color REAUCTION .....cuivie ettt 70, 71
FIEEE EFfECT. . .eiiiiiii i 28
(0] (o [T gVAY AT o o [0, PP 6, 103
G
General Settings (PreferenCes) ... 70
H
H I e Cover
Highlight Area Warning Indicator ............ccccoeveiieiiiviiiiiiie e, 51
HUB et 88
I
ICC PrOfilES ... ittt e e e e e eeeeas 117
Image Frame Information (Image Marks) ..........cccccvveeeeeevieerieeeeeennnnn. 105
Image Marks (Image Frame Information) ..........cccccccvviveiiieiinniinnnenn.. 105
Image Quality
Default Noise Reduction Settings..........ccovvvvvieiiieiiiiiiieeeee 73
False Color REAUCHION .....cove i e 70, 71
Improve the Quality of an Image (Main Window) ..........ccccvvveeenn.. 21
Noise Reduction of a JPEG Image (Luminance, Chrominance) .. 91
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 56
View and Save a RAW IMage .........ccceeeevvieeieeeeiiiiiiie e eeee e 70,71
Image Shooting Information DiSplay ..............eeeeeeiieeiieiiieiiieiieieneee. 10, 21
Improve the Quality of an Image (Main Window)..............ceeevveeeveeeeeen. 21
J
JPEG IMAGE. .. ittt e e e eeeeeeeeeeeeees 117
L
Lens Aberration COreCHION ..........iiiiiiii e 57
Lens Aberration Correction Window ...........ceveveveeeiieieiieeeeie e, 59, 113
[T TP PTPTPTRR 27
Loading and Pasting (Applying) RECIPES ......ccccvviiiiiiiiiiiieeeiiiiieeeee 78
Luminance Noise Reduction (JPEG, TIFF Images).........ccccevvvvvvvnnnnnn. 91
Luminance Noise Reduction (RAW IMages) ........ccccvvvvreeeeiiiiiiiiineneenn. 56
M
Main WINAOW ... 10, 103

Manual Dust Erasure (Repair FUNCLiON) ...........cccccvveeinvninniinninnnn, 63, 96
/T T Yo T 0] 1 o1 28
FIlter EffECT.....oiieeeeeeee s 28
TONING EffECT....uiiii e e 28
MoVE Or COPY FOIEIS .....coeeeiiiiiiieee e 46
MoVe OF COPY IMAGES ...ouuiiiiiiiiieeiin e 46
N
Noise Reduction (JPEG or TIFF IMage)............uuueeeieeeeeeeeeeiieeeeeeeeeeeenn. 91
Noise Reduction (RAW IMAQE) ......uuvrrrriiiriiiiiiieeieeeeieeieeeeeeeeeeeeeeeeeeeaees 56
Noise Reduction of a JPEG Image (Luminance, Chrominance) ......... 91
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 56
NR/Lens TOOol Palette ... 108
@)
(O o= a1 = T [ =T < 45
Organizing IMAGES ... .cuuireieeieeisiiitiiii et 45
Create 8 FOIAEN ......uuuiieieiiiiiiiiiiiiiiieiiiee ittt eeeeeeeeees 45
Delete IMAgES ......oeeiiiiiiiiiie e 45
Move or Copy FOIAErS..........ooviiiiiiiiiie e 46
Move or Copy IMAGES.......cooviiiiiiiiiieeeeee e, 46
Register Folders as BooOKMarks.........ccccccvvvveiiiiiiiiiiieee, 47
P
Peripheral lllumination CorreCtion ............ccc.vvvvevvveeeeeeieeeireerireeeeeeeeeeees 59
Personal White BalanCe ...............uuvuuiiiiiiiiiiiiiiiiiiiieeiiiieeeeeeeeeeeeeeeeeeeeees 79
PICLUIE SEYIE .o e e 24
Picture Style File.......c.ueieieeeieeeee e 53
L (] (=T =T o7 PP 70
Color Man@gEMENT .......cooiiiiiiiiiiie e 74
General SENGS ....vvuuvriiiiiiiiiiiiiiiiiirirr e ————————— 70
TOOI Palette ... ..o 73
RV A=Y 1] o 1 ST 72
Printing
Printing a Thumbnail List (Contact Sheet Printing) ...................... 67
Printing One Sheet of Paper.......cccccceeevieeeiiiecccie e, 14, 44
Printing Using Easy-PhotoPrint..........ccccooooevviiiiiiii e, 42
Printing Using Easy-PhotoPrint EX............cccc . 39
Printing with a High-End Canon Printer ...........ccccccceeiiiiiiiinnenenn. 68
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Printing with a Large-Format Canon Printer............cccccooooeeeei. 69
Printing with a Printer other than the Canon Printers.................... 44
Printing with Canon Inkjet Printers ..........ccccccoviiiiiiiieeeeenee 39, 42
Printing with Easy-PhotoPrint Pro ...........ccccccceiviiiiiii 68
Printing with Shooting Information (Detailed Setting Printing)...... 66
Rendering Intents when Using Easy-PhotoPrint ................... 74,75
Printing a Thumbnail List (Contact Sheet Printing) ..........ccovvvvevvveene... 67
Printing One Sheet of Paper ... 14, 44
Printing Using Easy-PhoOtOPTINt..............cuuuiiiiiiiiiiiiiiiieiieeiieeeeeeeeeeeeeeeee. 42
Printing Using Easy-PhotoPrint EX..............uuuuieiiiiiiiiiiiiiiiiiieieeeeeeeeeeee. 39
Printing with a High-End Canon Printer ............cccccvvvvvvvviveveeeeeeeeeeeeee, 68
Printing with a Large-Format Canon Printer ............ccccccvvvveeeveeeeeeenenn. 69
Printing with a Printer other than the Canon Printers...........cccccevuve..... 44
Printing with Canon Inkjet Printers.............eeveeiiiiiiieiiieeiiieieeeeeee. 39, 42
Printing with Easy-PhotoPrint Pro...........ccccvvvvvvviiiivieiiieiiieeeeeeeeeeveeeee, 68
Printing with Shooting Information (Detailed Setting Printing) ............ 66
Q
QUICK CheCKk WINAOW........ccuvuiiiiiiiiieeeee e 16, 109
QUILEING DPP ...t eernans 14
R
RAW IMAGE. ..ot e e 117
RAW TOOI PAlEIe ....evviiiiiee i 12, 107
Re-Adjusting @n IMAJE .........uuuuuiiiiiiiiiiiiiiiieiiieeeeeeeeeeeee e eeeeeeeeeas 39, 99
=0 o= 77,117
RECIPE FilE e e 77
Re-Editing an IMage ............uuuririiiiiiiiiiiiieiiiirierereerseereeeeeerereeeeereee 39, 99
Registering Folders as BOOKMArKS ..............uueuueiiiimeieeeiieiiieiieeeeeeeeeenee. a7
ReName WINAOW..........uuiiiiiiiiiiiiiiiceeeeesiee e 82, 116
Rendering Intent (Matching Method) ..., 118
Rendering Intents when Using Easy-PhotoPrint ................... 74,75
Rendering Intents when Using Easy-PhotoPrint...........cccccceeeee. 74,75
Repair (Manual DUSE Erasure) ..........ccoooourivieieeeenniiiiiieeeee e 63, 96
RGB TOOI PalELe .......uvviiiieiiiiiiiiiiieeee e 84, 107
Rotate Images......cccoovvvevviiiieeiieeei e 10, 23, 103, 104, 109, 110

S
SALUFALION .o 88
Save
Batch Convert/Save Images (Batch Process)...................... 80, 115
Convert to JPEG or TIFF Images and Save ........cccccceeeeeeeee. 38, 111
ST AT 37, 98
SAVE AS .ttt e et et e et e et e teaeeees 37,98
Save JPEG or TIFF Image as a Separate Image .........cccccvvvvunnnnn. 99
View and Save RAW IMagesS.......c.oovvviiiiniiieeeeeeiiein e eeeeeeans 70,71
S F: VL AN 37, 98
SaVING RECIPES....cc i 78
SeleCt IMAgES...coiiiii e, 10, 16, 31
Shadow Area Warning INdicator............ccoeeeiieiiiiiiiiiiccees 51
SNAIPNESS i 29, 88
Shooting Information Display............cccccoeiieee . 10,21
SNOMCUL KEYS ...t Cover
Single Image Display ..., 20
Single Image Display of RAW and JPEG Image...........ccccceeveeevriinnnen. 20
Sorting Images (Check Marks) .........ccccceevieei . 17,18
SRGB ...t a e e aaaes 118
Starting UP DPP ... 6
SUPPOIEd IMAGES ... 3
Synchronization (Edit WiNAOW)............ccoiiiiiiiiiiiiieeeee e 50
Synchronize Edit WINAOWS ..........ooouiiiiiii e e 50
SYNCNIONIZE IMAGES ... .eeiiiiiiiee e 50
System REQUIFEMENTES ....uvuuiii it e e e e e et e e e e e eeees 3
T
Thumbnail Display (Main Window) ..........ccccevuuiiiinineeeeeeeeeiiinnn. 10, 103
Change the DISPlay.........ccouiiuiiiiiiieeiie e 10
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 31
Thumbnail Display of Images (Main Window) ...........cccceevvvviiinieeennn, 10
Change the DISPlay.........ccouiiiiiiiiiiieeiee e 10
LIl 11 0= T [ PP 117
TONE CUINVE ..t e e e e e b e eeaaeeees 117
Tone Curve AdjusStmeENt.........coovvviiiiii . 54, 89
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Tone Curve Assist (Automatic Adjustment) ..........ocevvvvvvvviiereennnnn.. 30, 85
B e 11 o =t (= o PP 28
Tool Palette
NR/Lens Tool Palette ............ueeeeeiieiiiiiiiiiiieiieeiieeeeeeeeeeee e 108
RAW TOOI Palette.....uuuiieeeiiiiieecce e 107
RGB TOOI PAIELE .....eeieeeiiiiiiiiiiieeee e 107
Tool Palette (PreferenCes) ........uuvvevieeeiiiiieeiiiiiieeeeeeeeee et 73
Transfer
Batch Transfer Images to Image Editing Software...................... 81
Transfer an Image to Photoshop...........ccceeeieii v 65
Transfer an Image to Photoshop ... 65
THMMING AN IMAJE .. .uvvviiiiiiiiiiiiieieiieevieeeeeeeeeree e eeeeaereeeeeeerrrrreereeees 35, 92
TrimmMING WINAOW ........uvveiiiiiiiiiiiiiiiiiiiiieieeiiieeeeeeeeeeeeeeeeeeeeeeee 35,92, 112
\%
View Settings (PreferenCes) ..........uvvvviviiiiiiiiiiiiiiiiiniieeereeereseeeeseeereeeee. 72
W
WHhite BalanCe.........uuiiiiiiiiiece e 25
Click White BalanCe .............uuuueiiiiiiiiiiiiiieiiiiiiieieieeeeeeeeeeeeeeneen 26, 87
(7] (o g =10 0] 0 1=T 7= (0[P 52
COolOr WHEEL.... ..o e 52
Personal White BalanCe .............coceeeiiiiiiiiiiiiei e 79
Wide GamUEt RGB ........uiiiiiiiiiiiiiiiiecce e 118
WOTK COlOr SPACE......eeeeiiieiiiiiii it 65

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

> Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

@ Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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